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KATA PENGANTAR 

 

Puji syukur penyusun panjatkan kepada Tuhan Yang Maha Esa atas berkat dan rahmatnya 

sehingga “MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH)” ini dapat 

terselesaikan. Modul ini dibuat sebagai panduan bagi peserta Program Pengabdian Kepada 

Masyarakat (PKM) yang diadakan bagi Guru Sekolah Menengah Kejuruan (SMK) Teknik Komputer 

Jaringan dan Dosen Komputer dari Perguruan Tinggi se-Nusantara, pada hari Senin-Kamis, 8-Juni 

2020.  

Penyusun menyadari bahwa modul training ini masih jauh dari sempurna. Untuk itu kritik 

dan saran demi pengembangan modul training ini sangat diharapkan. Kritik dan saran dapat 

dikirimkan melalui email dengan alamat: putu.hariyadi@universitasbumigora.ac.id atau 

khairan.marzuki@universitasbumigora.ac.id. Terimakasih. 
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PENDAHULUAN 

 

 Adapun kebutuhan perangkat keras (hardware) dan lunak (software) yang diperlukan 

untuk dapat mengujicoba materi yang terdapat pada modul training ini adalah sebagai berikut: 

A. Kebutuhan Hardware 

Satu unit komputer dengan rekomendasi spesifikasi sebagai berikut: 

1. CPU: 64 bit. 

2. RAM: 8 GB. 

3. Hard drive. 

4. 1 (satu) Network Interface Card. 

B. Kebutuhan Software 

1. Proxmox Virtual Environment (VE) versi 5.3 yang dapat diunduh pada situs 

Proxmox di alamat https://www.proxmox.com/en/downloads 

2. VMWare Workstation 14 Pro atau 15 Pro. 

3. Putty SSH Client yang dapat diunduh pada alamat https://www.putty.org/ 

4. Browser Chrome yang dapat diunduh pada alamat 

https://www.google.com/chrome/. 

5. Mikrotik Cloud Hosted Router (CHR) dan Winbox yang dapat diunduh pada situs 

Mikrotik pada alamat https://mikrotik.com/download 

6. Linux Container Image Templates untuk Proxmox yang dapat diunduh pada 

alamat http://download.proxmox.com/images/system/ 

Selain itu juga diperlukan koneksi Internet untuk mengunduh perangkat lunak tersebut 

dan ujicoba materi. 

 

  

https://www.proxmox.com/en/downloads
https://www.putty.org/
https://www.google.com/chrome/
https://mikrotik.com/download
http://download.proxmox.com/images/system/
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BAB I 

INSTALASI DAN KONFIGURASI PROXMOX VE 5.3  

PADA VMWARE WORKSTATION 14 

 

A. Rancangan Jaringan Ujicoba 

Rancangan jaringan ujicoba terdiri dari 1 unit notebook dengan sistem operasi Windows 

10 yang telah diinstalasi VMWare Workstation Pro 14 sebagai hosted hypervisor, seperti 

terlihat pada gambar berikut: 

vmnet1
.2

Network
192.168.169.0/24

VMWare Workstation 14 Pro

Proxmox VE 5.3
Guest OS

vmbr0
.1

Windows 10
Host Operating 

System (OS)

 

Pada VMWare Workstation akan dibuat Guest Virtual Machine dengan Operating System (OS) 

Proxmox VE 5.3. Alamat jaringan yang digunakan adalah 192.168.169.0/24 dengan alokasi 

pengalamatan IP meliputi 192.168.169.1 untuk interface vmbr0 di Guest OS Proxmox  dan 

192.168.169.2 untuk interface vmnet1 di Windows 10. 

B. Instalasi Proxmox VE 5.3 

Adapun langkah-langkah instalasi dan konfigurasi Proxmox VE 5.3 pada VMWare 

Workstation 14 Pro adalah sebagai berikut: 

1. Jalankan aplikasi VMWare Workstation 14 Pro melalui Start > VMWare > VMWare 

Workstation Pro. 
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2. Tampil aplikasi VMWare Workstation. Untuk membuat virtual machine baru, pilih menu 

File > New Virtual Machine …, seperti terlihat pada gambar berikut: 

 

3. Tampil kotak dialog New Virtual Machine Wizard untuk menentukan jenis konfigurasi 

virtual machine yang ingin dibuat, seperti terlihat pada gambar berikut: 

 

Terdapat 2 pilihan jenis konfigurasi yang dapat dipilih yaitu Typical (recommended) dan 

Custom (advanced). Jenis konfigurasi Typical disarankan untuk dipilih ketika ingin 

membuat virtual machine melalui beberapa tahapan dengan mudah. Sebaliknya jenis 

konfigurasi Custom akan memberikan pilihan pengaturan lanjutan seperti penentuan 
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jenis controller SCSI, jenis virtual disk dan kompatibilitas dengan produk VMWare versi 

sebelumnya. Pilih Typical, dan klik tombol Next > untuk melanjutkan. 

4. Tampil kotak dialog Guest Operating System Installation untuk menentukan bagaimana 

cara instalasi sistem operasi dilakukan, seperti terlihat pada gambar berikut: 

 

Terdapat 3 pilihan yaitu Install from Installer disc untuk menginstalasi dari media disc 

seperti CD/DVD, Install from Installer disc image file (iso) untuk menginstalasi dari file ISO, 

dan I will install the operating system later untuk mempersiapkan virtual machine dengan 

hardisk kosong tanpa melakukan instalasi sistem operasi. Pilih I will install the operating 

system later, dan klik tombol Next > untuk melanjutkan. 

5. Tampil kotak dialog Select a Guest Operating System untuk menentukan jenis sistem 

operasi yang akan diinstalasi pada virtual machine yang dibuat, seperti ditunjukkan pada 

gambar berikut: 
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Pilih Other pada bagian Guest operating system dan Other 64-bit pada bagian Version. Klik 

tombol Next > untuk melanjutkan. 

6. Tampil kotak dialog Name the Virtual Machine untuk menentukan nama pengenal virtual 

machine dan menentukan lokasi penyimpanan file virtual machine yang dibuat, seperti 

terlihat pada gambar berikut: 
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Pada bagian Virtual machine name masukkan nama pengenal virtual machine, sebagai 

contoh Proxmox VE. Sedangkan pada bagian Location tentukan lokasi penyimpanan file 

virtual machine yang dibuat dengan cara menekan tombol Browse … sebagai contoh 

diletakkan di D:\Proxmox VE. Klik tombol Next > untuk melanjutkan. 

7. Tampil kotak dialog Specify Disk Capacity untuk menentukan kapasitas media 

penyimpanan yang dialokasikan untuk virtual machine yang dibuat, seperti terlihat pada 

gambar berikut: 

 

Pada bagian Maximum disk size (GB) masukkan kapasitas media penyimpanan (hardisk) 

yang dialokasikan untuk virtual machine yang dibuat, sebagai contoh 40 GB. Klik tombol 

Next > untuk melanjutkan. 

8. Tampil kotak dialog Ready to Create Virtual Machine yang menampilkan informasi 

ringkasan pengaturan yang telah ditentukan untuk virtual machine yang akan dibuat, 

seperti terlihat pada gambar berikut: 
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Klik tombol Finish untuk membuat virtual machine. 

9. Tampil kotak dialog yang menampilkan virtual machine yang telah berhasil dibuat yaitu 

dengan nama pengenal Proxmox VE, seperti terlihat pada gambar berikut: 

 

Selanjutnya klik Edit virtual machine settings untuk melakukan perubahan pada 

pengaturan virtual machine untuk beberapa komponen hardware, seperti terlihat pada 

gambar berikut: 
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10. Tampil kotak dialog Virtual Machine Settings. Pada tab Hardware di panel sebelah kiri 

pilih Memory. Selanjutnya pada panel detail sebelah kanan lakukan penyesuaian ukuran 

memori yang dialokasikan untuk virtual machine di parameter Memory for this virtual 

Machine sebagai contoh dialokasikan 2 GB, seperti terlihat pada gambar berikut: 
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11. Pada tab Hardware di panel sebelah kiri dari Virtual Machine Settings pilih Processors. 

Selanjutnya pada panel sebelah kanan, lakukan pengaktifan nested virtualization atau 

virtualization engine dengan mencentang pada 3 (tiga) pilihan parameter yaitu antara lain 

Virtualize Intel VT-x/EPT or AMD-V/RVI, Virtualize CPU performance counters dan 

Virtualize IOMMU (IO memory management unit), seperti terlihat pada gambar berikut: 

 

12. Pada tab Hardware di panel sebelah kiri dari Virtual Machine Settings pilih CD/DVD (IDE) 

untuk mengarahkan ke lokasi penyimpanan file ISO dari Proxmox VE 5.3. Selanjutnya 

pada panel sebelah kanan akan muncul detail pengaturan CD/DVD. Pada bagian 

Connection,  pilih Use ISO image file, dan klik tombol Browse… untuk mengarahkan ke 
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lokasi penyimpanan file ISO dari Proxmox VE 5.3 yang akan digunakan sebagai media 

sumber instalasi, sebagai contoh terdapat di drive D:\Master\proxmox-ve_5.3-1.iso, 

seperti terlihat pada gambar berikut: 

 

13. Pada tab Hardware di panel sebelah kiri dari Virtual Machine Settings pilih Network 

Adapter. Selanjutnya pada panel sebelah kanan akan muncul detail pengaturan Network 

Adapter. Pada bagian Network connection beberapa pilihan jenis koneksi jaringan yang 

dapat digunakan oleh Network Adapter yaitu Bridged (untuk dapat terhubung secara 

langsung ke jaringan fisik), Network Address Translation (NAT - untuk berbagi pakai 

alamat IP dari host), Host-only (untuk terhubung ke jaringan privat yang dibagi pakai 

dengan host), dan Custom (untuk secara spesifik menentukan virtual network yang ingin 

digunakan). Pada bagian Network connection dipilih Host-only, seperti terlihat pada 

gambar berikut: 
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Klik tombol OK untuk menutup kotak dialog Virtual Machine Settings. Selanjutnya klik 

Power on the virtual machine untuk menghidupkan virtual machine dan memulai 

instalasi Proxmox VE 5.3 pada virtual machine yang telah dibuat, seperti terlihat pada 

gambar berikut: 

 

14. Tampil menu awal instalasi berupa Welcome to Proxmox Virtual Environment untuk 

menentukan jenis instalasi yang akan dilakukan, seperti terlihat pada gambar berikut: 

 

Terdapat beberapa pilihan yang tampil yaitu Install Proxmox VE (untuk menginstalasi 

secara normal), Install Proxmox VE (Debug mode) untuk menginstalasi pada mode debug 

yang akan membuka shell console pada beberapa tahapan instalasi dimana umumnya 

digunakan oleh developer, Rescue Boot (untuk memperbaiki sistem Proxmox yang telah 

terinstalasi ketika tidak dapat melakukan booting dengan normal), Test Memory (untuk 

melakukan pengujian pada RAM yang terpasang pada komputer apakah berfungsi dan 

bebas dari kesalahan atau error). Secara default telah terpilih Install Proxmox VE. Tekan 

tombol Enter untuk melanjutkan instalasi pada mode tersebut. 
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15. Tampil kotak dialog persetujuan lisensi “GNU Affero General Public License”, seperti 

terlihat pada gambar berikut: 

 

Klik tombol I Agree untuk menyetujui lisensi dan melanjutkan instalasi. 

16. Tampil kotak dialog Proxmox Virtualization Environment (PVE) untuk memilih Target 

hardisk sebagai lokasi instalasi, seperti terlihat pada gambar berikut: 
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Terlihat Target Hardisk yang telah terpilih adalah /dev/sda dengan kapasitas 40GB. 

Installer Proxmox akan secara otomatis membuat partisi pada hardisk dan menginstalasi 

paket-paket yang dibutuhkan serta membuat sistem dapat di boot dari hardisk. 

Perhatian: keseluruhan partisi dan data akan hilang. Installer akan menggunakan Logical 

Volume Manager (LVM) apabila file system yang dipilih adalah ext3, ext4 atau xfs. Secara 

default telah terpilih ext4. Jika diperlukan dapat pula dilakukan pengaturan jenis file 

system dan parameter LVM lainnya dengan menekan tombol Options.  

Klik tombol Next untuk melanjutkan instalasi. 

17. Tampil kotak dialog “Location and Time Zone selection” untuk mengatur Country, Time 

zone dan  Keyboard Layout, seperti terlihat pada gambar berikut: 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 14 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

 

Pada isian Country masukkan Indonesia. Sedangkan pengaturan zone waktu dapat 

dilakukan dengan memilih menu dropdown dari parameter Time zone. Untuk Waktu 

Indonesia Barat (WIB) pilih Asia/Jakarta, untuk Waktu Indonesia Tengah (WITA) pilih 

Asia/Makassar, sedangkan Wilayah Indonesia Timur (WIT) pilih Asia/Jayapura. Pilih 

Asia/Makassar. Klik tombol Next untuk melanjutkan. 

18. Tampil kotak dialog Administration Password and E-mail Address untuk mengatur 

Password dari user “root” dan E-mail, seperti terlihat pada gambar berikut: 
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Pada isian Password dan Confirm, masukkan sandi login yang akan digunakan oleh user 

“root”, sebagai contoh “12345678”. Sedangkan pada isian E-mail, masukkan alamat 

untuk yang akan digunakan oleh Proxmox untuk mengirimkan notifikasi terkait kegagalan 

backup, high availability events, dan lainnya, sebagai contoh admin@iputuhariyadi.net. 

Tekan tombol Next untuk melanjutkan instalasi. 

19. Tampil kotak dialog Management Network Configuration untuk mengatur konfigurasi 

jaringan. Lengkapi isian dari masing-masing parameter berikut: 

a) Hostname (FQDN), masukkan nama komputer dengan format Fully Qualified 

Domain Name, sebagai contoh pve.iputuhariyadi.net. 

b) IP Address, masukkan alamat IP yang digunakan oleh Proxmox yaitu 

192.168.169.1 sesuai dengan rancangan jaringan ujicoba. 

c) Netmask, masukkan alamat subnetmask yaitu 255.255.255.0. 

d) Gateway, masukkan alamat gateway untuk komunikasi ke beda jaringan atau ke 

Internet, sebagai contoh 192.168.169.254. 

e) DNS Server, masukkan alamat server Domain Name System (DNS) untuk 

mentranslasikan nama domain ke alamat IP dan sebaliknya, sebagai contoh 

192.168.169.254. 

seperti terlihat pada gambar berikut: 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 16 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

 

Tekan tombol Next untuk melanjutkan instalasi. 

20. Tampil kotak dialog yang menampilkan proses pembuatan partisi, format hardisk dan 

penyalinan paket-paket ke target hardisk, seperti terlihat pada gambar berikut: 
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Tunggu hingga proses instalasi selesai. 

21. Tampil kotak dialog Installation successful! yang menginformasikan instalasi Proxmox VE 

telah selesai diinstalasi dan siap digunakn, seperti terlihat pada gambar berikut: 
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Tekan tombol Reboot. Tunggu hingga proses reboot selesai dilakukan. Setelah proses 

reboot selesai dilakukan maka akan tampak prompt login untuk otentikasi sebelum dapat 

mengakses sistem Proxmox, seperti terlihat pada gambar berikut: 

 

Konfigurasi selanjutnya dapat dilakukan melalui antarmuka web dari Proxmox yang dapat 

diakses pada alamat http://192.168.169.1:8006. 

 

C. Konfigurasi Client Windows 10 

Adapun langkah-langkah konfigurasi yang dilakukan pada Client Windows 10 adalah sebagai 

berikut: 

1. Mengatur pengalamatan IP dan parameter TCP/IP lainnya melalui taskbar bagian pojok 

kanan bawah dengan cara klik kanan pada icon Network dan pilih Open Network & Sharing 

Center, seperti terlihat pada gambar berikut: 

 

2. Tampil kotak dialog Network and Sharing Center. Pilih Change Adapter Settings, seperti 

terlihat pada gambar berikut:  
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3. Tampil kotak dialog Network Connections. Klik dua kali pada VMWare Network Adapter 

VMNet1, seperti terlihat pada gambar berikut: 

 

4. Tampil kotak dialog VMware Network Adapter VMnet1 Status. Klik tombol Properties, 

seperti terlihat pada gambar berikut: 

 

5. Tampil kotak dialog VMware Network Adapter VMnet1 Properties. Pada bagian “This 

connection uses the following items:”, klik dua kali pada pilihan Internet Protocol Version 4 

(TCP/IPv4), seperti terlihat pada gambar berikut: 
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6. Tampil kotak dialog Internet Protocol Version 4 (TCP/IPv4) Properties. Pilih Use the following 

IP Address, seperti terlihat pada gambar berikut: 

 

Pada isian IP address:, masukkan 192.168.169.2. Sedangkan pada isian Subnet mask:, 

masukkan 255.255.255.0. Klik tombol OK > OK > Close. Tutup kotak dialog Network and 

Sharing Center. 
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7. Buka Command Prompt Windows dengan menekan tombol Windows+R. Pada inputan form 

yang tampil, ketik“cmd” dan tekan tombol Enter. 

 

8. Pada Command Prompt masukkan perintah “ipconfig/all | more” untuk memverifikasi 

pengalamatan IP yang telah diatur, seperti terlihat pada gambar berikut: 

 

Tekan tombol spasi untuk menampilkan layar berikutnya. Pastikan adapter VMware Network 

Adapter VMnet1 telah menggunakan alamat IP dan subnetmask yang telah diatur pada 

langkah sebelumnya, seperti terlihat pada gambar berikut: 

 

Tekan tombol q untuk keluar. 
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9. Verifikasi koneksi dari client Windows 10 ke VM Proxmox menggunakan perintah “ping 

192.168.169.1” pada Command Prompt Windows, seperti terlihat pada gambar berikut: 

 

Terlihat koneksi ke VM Proxmox telah berhasil dilakukan. 

 

D. Konfigurasi Proxmox VE 5.3 

Adapun langkah-langkah untuk mengkonfigurasi Proxmox VE 5.3 melalui antarmuka 

berbasis web adalah sebagai berikut: 

1. Buka browser sebagai contoh menggunakan Chrome. Pada address bar dari browser, 

masukkan URL https://192.168.169.1:8006. Hasil pengaksesan, seperti terlihat pada 

gambar berikut: 

 

https://192.168.169.1:8006/


 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 23 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

Tampil pesan peringatan “Your connection is not private”. Klik Advanced untuk 

melanjutkan pengaksesan dan klik link “Proceed to 192.168.169.1 (unsafe)”, seperti 

terlihat pada gambar berikut: 

 

Maka web interface dari konfigurasi Proxmox berhasil diakses, seperti terlihat pada 

gambar berikut: 
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2. Pada kotak dialog otentikasi Proxmox VE Login, lengkapi isian “User name” dan 

“Password”. Pada isian “User name”, masukkan “root”. Sedangkan pada isian 

“Password”, masukkan sandi login dari user “root” yaitu 12345678, seperti terlihat pada 

gambar berikut:  

 

Klik tombol Login. 

3. Tampil kotak dialog “No valid subscription” yang menginformasikan bahwa Anda tidak 

memiliki subscription yang valid untuk server ini, seperti terlihat pada gambar berikut: 

 

Pilihan jenis subscription dapat diakses lebih lanjut pada situs Proxmox di alamat 

www.proxmox.com. Klik tombol OK. 

4. Tampil halaman Server View dari Proxmox, seperti terlihat pada gambar berikut: 

http://www.proxmox.com/


 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 25 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

 

Selanjutnya Anda dapat melakukan aktivitas manajemen Proxmox seperti mengunggah 

file image Template Linux Container atau file ISO image, pembuatan Virtual Machine 

(Create VM) atau Container (Create CT) dan lain sebagainya. 

 

Untuk keluar dari web interface konfigurasi Proxmox, klik Logout. 

 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 26 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

BAB II 

MENONAKTIFKAN PESAN NOTIFIKASI “NO VALID SUBSCRIPTION”  

PADA PROXMOX VE 5.3 

 

Setelah berhasil melakukan “Instalasi dan Konfigurasi Proxmox VE 5.3 pada VMware 

Workstation 14” di bab sebelumnya maka selanjutnya akan dilakukan penonaktifan pesan 

notifikasi “No Valid Subscription”. Pesan notifikasi ini akan selalu tampil ketika pengguna telah 

berhasil melalui proses otentikasi login pada web interface Proxmox. Proses penonaktifan pesan 

notifikasi tersebut memerlukan akses console atau remote access melalui Secure Shell (SSH).  

Adapun langkah-langkah penonaktifan pesan notifikasi tersebut melalui SSH adalah 

sebagai berikut: 

1. Jalankan aplikasi SSH Client, sebagai contoh menggunakan Putty. Tampil kotak dialog Putty 

Configuration. Pada isian Host Name (or IP Address), masukkan alamat IP dari Server Proxmox 

yaitu 192.168.169.1, seperti terlihat pada gambar berikut: 

 

Klik tombol Open. 
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2. Tampil kotak dialog Putty Security Alert yang menampilkan pesan peringatan terkait potensi 

pelanggaran keamanan, seperti terlihat pada gambar berikut: 

 

Klik tombol Yes untuk melanjutkan. 

3. Tampil kotak dialog Putty yang meminta pengguna untuk melakukan proses otentikasi login 

ke Server Proxmox, seperti terlihat pada gambar berikut: 

 

Pada inputan login as:, masukkan “root” dan tekan tombol Enter. Selanjutnya tampil inputan 

password:, masukkan “12345678” dan tekan tombol Enter. Apabila proses otentikasi berhasil 

dilakukan maka akan tampil shell prompt #. 
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4. Mengubah parameter pada file "/usr/share/javascript/proxmox-widget-

toolkit/proxmoxlib.js" yaitu: if (data.status !== 'Active') menjadi if 

(false) dengan cara mengeksekusi perintah berikut: 

# sed -i "s/data.status !== 'Active'/false/g" 

/usr/share/javascript/proxmox-widget-toolkit/proxmoxlib.js 

5. Keluar dari SSH. 

# exit 

6. Memverifikasi hasil penonaktifkan pesan notifikasi dengan mengakses web interface dari 

Proxmox. Buka browser, sebagai contoh menggunakan Chrome. Pada address bar dari 

browser, masukkan URL https://192.168.169.1:8006. 

7. Tampil kotak dialog otentikasi Proxmox VE Login, lengkapi isian “User name” dan 

“Password”. Pada isian “User name”, masukkan “root”. Sedangkan pada isian “Password”, 

masukkan sandi login dari user “root” yaitu 12345678, seperti terlihat pada gambar berikut:  

 

Klik tombol Login. Pesan notifikasi “No Valid Subscription” tidak tampil. Pengguna langsung 

diarahkan ke tampilan halaman Server View dari Proxmox, seperti pada gambar berikut: 

https://192.168.169.1:8006/
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Selamat Anda telah berhasil menonaktifkan pesan notifikasi “No Valid Subscription” pada 

Proxmox VE 5.3. Untuk keluar dari web interface konfigurasi Proxmox, klik Logout. 

 

Apabila pesan notifikasi masih tampil, maka lakukan penghapusan Cookies dari browser 

dengan menekan tombol CTRL+SHIFT+DEL. Tampil kotak dialog, Clear browsing data. Pada 

pilihan Time range, pilih All time, dan tekan tombol CLEAR DATA, seperti terlihat pada 

gambar berikut: 
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Selanjutnya lakukan percobaan pengaksesan kembali ke web interface dari Proxmox pada 

alamat https://192.168.169.1:8006. 
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BAB III 

MENONAKTIFKAN PVE ENTERPRISE SUBSCRIPTION  

DAN MENGAKTIFKAN PVE NO-SUBSCRIPTION REPOSITORY  

PADA PROXMOX VE 5.3 

 

Menurut Wiki dari Proxmox, secara default PVE Enterprise Subscription telah aktif dan 

merupakan repository default dan direkomendasikan bagi pengguna PVE yang melakukan 

subscription karena memuat paket yang paling stabil sehingga sangat cocok digunakan untuk 

production. Untuk dapat memanfaatkan repository ini maka diperlukan subscription key yang 

BERBAYAR. Detail informasi pembiayaan terkait PVE subscription dapat dilihat pada alamat 

https://www.proxmox.com/en/proxmox-ve/pricing. File yang memuat pengaturan PVE 

Enterprise Subscription adalah /etc/apt/sources.list.d/pve-enterprise.list, 

dengan konten seperti berikut: 

deb https://enterprise.proxmox.com/debian/pve stretch pve-enterprise 

 

Penonaktifan PVE Enterprise subscription diperlukan apabila tidak memiliki subscription key 

sehingga tidak memunculkan pesan kesalahan. Bagi pengguna PVE yang tidak memiliki 

subscription key dapat memanfaatkan PVE No-subscription repository. 

Adapun langkah-langkah untuk menonaktifkan PVE Enterprise Subscription dan 

mengaktifkan PVE NO-subscription melalui SSH adalah sebagai berikut: 

1. Jalankan aplikasi SSH Client, sebagai contoh menggunakan Putty. Tampil kotak dialog Putty 

Configuration. Pada isian Host Name (or IP Address), masukkan alamat IP dari Server Proxmox 

yaitu 192.168.169.1, seperti terlihat pada gambar berikut: 

https://www.proxmox.com/en/proxmox-ve/pricing
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Klik tombol Open. 

2. Tampil kotak dialog Putty yang meminta pengguna untuk melakukan proses otentikasi login 

ke Server Proxmox, seperti terlihat pada gambar berikut: 

 

Pada inputan login as:, masukkan “root” dan tekan tombol Enter. Selanjutnya tampil inputan 

password:, masukkan “12345678” dan tekan tombol Enter. Apabila proses otentikasi berhasil 

dilakukan maka akan tampil shell prompt #. 

3. Menonaktifkan PVE Enterprise subscription dengan cara menambahkan tanda # diawal baris 

dari konten pada file /etc/apt/sources.list.d/pve-enterprise.list 

menggunakan editor nano. 
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# nano /etc/apt/sources.list.d/pve-enterprise.list 

 

Simpan perubahan dengan menekan tombol CTRL+O dan tekan Enter. Tekan tombol CTRL+X 

untuk keluar dari editor nano. 

4. Memverifikasi hasil penonaktifan PVE Enterprise subscription menggunakan perintah “cat 

/etc/apt/sources.list.d/pve-enterprise.list”. 

 

Terlihat pada awal baris dari file pve-enterprise.list telah terdapat tanda # yang 

berfungsi sebagai komentar. 

5. Mengaktifkan PVE No-subscription repository dengan cara menambahkan parameter “deb 

http://download.proxmox.com/debian/pve stretch pve-no-

subscription” pada file /etc/apt/sources.list menggunakan editor nano. 

# nano /etc/apt/sources.list 

 

Simpan perubahan dengan menekan tombol CTRL+O dan tekan Enter. Tekan tombol CTRL+X 

untuk keluar dari editor nano. 

6. Memverifikasi hasil pengaturan PVE No-subscription repository menggunakan perintah “cat 

/etc/apt/sources.list”. 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 34 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 
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BAB IV 

INSTALASI DAN KONFIGURASI LINUX CONTAINER (LXC)  

CENTOS 7 PADA PROXMOX VE 5.3 

 

Pada bab ini akan dibahas penerapan teknologi virtualisasi yang didukung oleh Proxmox 

VE yaitu Linux Container (LXC) menggunakan CentOS 7. Menurut situs Proxmox, LXC merupakan 

lingkungan virtualisasi level sistem operasi untuk menjalankan beberapa sistem Linux terisolasi 

pada sebuah kontrol host Linux. LXC menjadi alternatif dari full machine virtualization yang 

menawarkan low overhead. Container akan menggunakan sistem operasi dari host daripada 

mengemulasikan sistem operasi secara lengkap sehingga berdampak pada keseluruhan container 

menggunakan kernel yang sama dan dapat mengakses sumber daya secara langsung dari host. 

Pengguna Linux dapat membuat dan memanajemen container sistem atau aplikasi menggunakan 

Application Programming Interface (API).  

Pembahasan pada bab ini terdiri dari 2 (dua) bagian yaitu (a) Rancangan Jaringan Ujicoba, 

(b) Instalasi dan Konfigurasi LXC CentOS 7 pada Proxmox VE.  

 

A. RANCANGAN JARINGAN UJICOBA 

Rancangan jaringan ujicoba yang digunakan, seperti terlihat pada gambar berikut: 

https://www.proxmox.com/
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Pada Server Proxmox VE 5.3 akan dilakukan pembuatan 2 (dua) Container (CT) dengan sistem 

operasi CentOS 7 yaitu menggunakan VM ID 100 dengan alamat IP 192.168.169.100/24 dan 

VM ID 101 dengan alamat IP 192.168.169.101/24. 

 

B. INSTALASI DAN KONFIGURASI LXC CENTOS 7 UNTUK VM ID 100 PADA PROXMOX VE 

Adapun langkah-langkah instalasi dan konfigurasi LXC CentOS 7 untuk VM ID 100 pada 

Proxmox VE adalah sebagai berikut: 

1. Buka browser, sebagai contoh menggunakan Chrome. Pada address bar dari browser, 

masukkan URL https://192.168.169.1:8006. 

2. Tampil kotak dialog otentikasi Proxmox VE Login, lengkapi isian “User name” dan 

“Password”. Pada isian “User name”, masukkan “root”. Sedangkan pada isian 

“Password”, masukkan sandi login dari user “root” yaitu 12345678, seperti terlihat 

pada gambar berikut:  

https://192.168.169.1:8006/
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Klik tombol Login. Pengguna langsung diarahkan ke tampilan halaman Server View dari 

Proxmox. 

3. Mengunggah file template container ke Server Proxmox dengan mengakses node 

“pve” di bawah menu Datacenter pada panel sebelah kiri dan memilih storage local 

(pve). Pilih menu Content pada panel sebelah kanan dari local (pve) dan pilih Upload 

untuk menggunggah file template container CentOS 7, seperti terlihat pada gambar 

berikut: 

 

Tampil kotak dialog Upload, seperti terlihat pada gambar berikut: 

 

Terdapat beberapa parameter yang harus diatur yaitu: 

a) Content:, pilih Container Template.  



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 38 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

b) Tekan tombol Select File… untuk mengarahkan ke lokasi direktori 

penyimpanan file template CentOS 7, sebagai contoh di D:\Master\ centos-7-

default_20170504_amd64.tar.xz, seperti terlihat pada gambar berikut: 

 

 

Tekan tombol Upload dan tunggu hingga proses pengunggahan file selesai dilakukan. 

Apabila proses unggah berhasil dilakukan maka pada bagian Content dari storage local 

(pve) akan menampilkan nama file centos-7-default_20170504_amd64.tar.xz,  seperti 

terlihat pada gambar berikut: 

 

File container template juga dapat diunduh langsung dari Internet dengan menekan 

tombol Templates di bagian Content dari storage local (pve), seperti terlihat pada 

gambar berikut: 
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Pada kotak dialog Templates yang tampil, pilih package yang ingin diunduh dan tekan 

tombol Download, seperti terlihat pada gambar berikut: 

 

Tunggu hingga proses unduh selesai dilakukan. Atau file template container juga dapat 

diunduh secara manual melalui alamat 

http://download.proxmox.com/images/system/, seperti terlihat pada gambar berikut: 

 

http://download.proxmox.com/images/system/
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Selanjutnya file template container yang telah diunduh dapat diunggah ke Server 

Proxmox dengan mengikuti langkah-langkah proses unggah template CentOS7 yang 

telah dijelaskan sebelumnya. 

4. Membuat Container dengan cara klik kanan pada node “pve” dibawah menu 

Datacenter di panel sebelah kiri dan memilih Create CT, seperti terlihat pada gambar 

berikut: 

 

Tampil kotak dialog Create: LXC Container. Terdapat beberapa parameter yang diatur 

di bagian General dari LXC Container, seperti terlihat pada gambar berikut: 
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Pada parameter Hostname:, masukkan nama komputer dan nama domain dari 

Container CentOS 7, sebagai contoh “server100.ubg.local”. Sedangkan pada 

parameter Password: dan Confirm password:, masukkan sandi login dari user “root” 

untuk container CentOS 7, sebagai contoh “12345678”. Klik tombol Next untuk 

melanjutkan. 

Tampil kotak dialog pengaturan bagian Template dari LNX Container. Pilih centos-7-

default_20170504_amd64.tar.xz pada parameter Template:, seperti terlihat pada 

gambar berikut: 

 

Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog pengaturan bagian Root Disk dari LNX Container. Lakukan 

penyesuaian ukuran hardisk yang digunakan pada parameter Disk size (GB):, sebagai 

contoh menggunakan 4 GB, seperti terlihat pada gambar berikut: 

 

Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog pengaturan CPU dari LNX Container. Pada parameter Cores:, 

lakukan penyesuaian jumlah Core CPU yang digunakan apabila diperlukan. Secara 

default bernilai 1 (satu), seperti terlihat pada gambar berikut: 
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Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog pengaturan Memory dari LNX Container. Terdapat 2 (dua) 

parameter yang dapat diatur yaitu Memory (MB) dan Swap (MB). Secara default 

masing-masing parameter tersebut bernilai 512 MB, seperti terlihat pada gambar 

berikut: 

 

Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog pengaturan Network dari LNX Container. Pada parameter 

IPv4/CIDR: masukkan alamat IP dan subnetmask yang digunakan oleh container 

CentOS 7 yaitu 192.168.169.100/24. Sedangkan pada bagian Gateway (IPv4):, 

masukkan alamat IP 192.168.169.254, seperti terlihat pada gambar berikut: 

 

Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog pengaturan DNS dari LNX Container. Pada parameter DNS 

domain: masukkan nama domain yang digunakan oleh container CentOS 7, sebagai 

contoh menggunakan “ubg.local”. Sedangkan pada bagian DNS server1:, masukkan 

alamat IP dari Primary Name Server, sebagai contoh menggunakan alamat IP 

192.168.169.254, seperti terlihat pada gambar berikut: 
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Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog Confirm dari LNX Container yang menampilkan ringkasan 

pengaturan yang telah dilakukan terkait pembuatan container CentOS 7, seperti 

terlihat pada gambar berikut: 

 

Klik tombol Finish. 

Tampil kotak dialog Task viewer: CT 100 – Create. Tunggu hingga proses pembuatan 

container CentOS 7 selesai dibuat dimana ditandai dengan pesan “TASK OK” pada 

bagian Output dari kotak dialog Task viewer: CT 100 – Create, seperti terlihat pada 

gambar berikut:  
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Tutup kotak dialog Task viewer: CT 100 – Create. 

Hasil dari pembuatan container CentOS 7 dengan ID 100, seperti terlihat pada gambar 

berikut: 

 

5. Untuk menjalankan Container CentOS 7, klik kanan pada “100 (server100.ubg.local)” 

di bawah node “pve” dari menu Datacenter dan pilih Start, seperti terlihat pada 

gambar berikut: 
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Container CentOS 7 berhasil dijalankan dimana ditandai dengan pesan status OK untuk 

CT 100 - Start pada bagian Tasks dari Log Panel, seperti terlihat pada gambar berikut: 

 

6. Untuk mengakses tampilan dari CT 100, pilih Console pada panel sebelah kanan dari 

CT 100 (server100.ubg.local), seperti terlihat pada gambar berikut: 

 

Tampil inputan Server Login untuk proses otentikasi sebelum pengguna dapat 

mengakses Command Line Interface (CLI) dari Container CentOS 7. Masukkan nama 

login “root” pada inputan Server Login dan tekan tombol Enter.  

Tampil inputan Password:, masukkan sandi login dari user “root” yaitu “12345678”, 

dan tekan tombol Enter. Apabila proses otentikasi login berhasil dilakukan maka akan 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 46 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

tampil prompt CLI dari container CentOS 7 yang ditandai dengan tanda #, seperti 

terlihat pada gambar berikut: 

 

7. Untuk mematikan container CentOS 7, pada Console dari web interface administrasi 

Proxmox eksekusi perintah “poweroff”, seperti terlihat pada gambar berikut: 

 

Tunggu hingga proses shutdown selesai dilakukan. 

 

C. INSTALASI DAN KONFIGURASI LXC CENTOS 7 UNTUK VM ID 101 PADA PROXMOX VE 

Adapun langkah-langkah instalasi dan konfigurasi LXC CentOS 7 untuk VM ID 101 pada 

Proxmox VE adalah sebagai berikut: 

1. Membuat Container dengan cara klik kanan pada node “pve” dibawah menu 

Datacenter di panel sebelah kiri dan memilih Create CT, seperti terlihat pada gambar 

berikut: 
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Tampil kotak dialog Create: LXC Container. Terdapat beberapa parameter yang diatur 

di bagian General dari LXC Container, seperti terlihat pada gambar berikut: 

 

Pada parameter Hostname:, masukkan nama komputer dan nama domain dari 

Container CentOS 7, sebagai contoh “server101.ubg.local”. Sedangkan pada 

parameter Password: dan Confirm password:, masukkan sandi login dari user “root” 

untuk container CentOS 7, sebagai contoh “12345678”. Klik tombol Next untuk 

melanjutkan. 

Tampil kotak dialog pengaturan bagian Template dari LNX Container. Pilih centos-7-

default_20170504_amd64.tar.xz pada parameter Template:, seperti terlihat pada 

gambar berikut: 
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Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog pengaturan bagian Root Disk dari LNX Container. Lakukan 

penyesuaian ukuran hardisk yang digunakan pada parameter Disk size (GB):, sebagai 

contoh menggunakan 4 GB, seperti terlihat pada gambar berikut: 

 

Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog pengaturan CPU dari LNX Container. Pada parameter Cores:, 

lakukan penyesuaian jumlah Core CPU yang digunakan apabila diperlukan. Secara 

default bernilai 1 (satu), seperti terlihat pada gambar berikut: 

 

Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog pengaturan Memory dari LNX Container. Terdapat 2 (dua) 

parameter yang dapat diatur yaitu Memory (MB) dan Swap (MB). Secara default 

masing-masing parameter tersebut bernilai 512 MB, seperti terlihat pada gambar 

berikut: 

 

Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog pengaturan Network dari LNX Container. Pada parameter 

IPv4/CIDR: masukkan alamat IP dan subnetmask yang digunakan oleh container 
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CentOS 7 yaitu 192.168.169.101/24. Sedangkan pada bagian Gateway (IPv4):, 

masukkan alamat IP 192.168.169.254, seperti terlihat pada gambar berikut: 

 

Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog pengaturan DNS dari LNX Container. Pada parameter DNS 

domain: masukkan nama domain yang digunakan oleh container CentOS 7, sebagai 

contoh menggunakan “ubg.local”. Sedangkan pada bagian DNS server1:, masukkan 

alamat IP dari Primary Name Server, sebagai contoh menggunakan alamat IP 

192.168.169.254, seperti terlihat pada gambar berikut: 

 

Klik tombol Next untuk melanjutkan. 

Tampil kotak dialog Confirm dari LNX Container yang menampilkan ringkasan 

pengaturan yang telah dilakukan terkait pembuatan container CentOS 7, seperti 

terlihat pada gambar berikut: 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 50 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

 

Klik tombol Finish. 

Tampil kotak dialog Task viewer: CT 101 – Create. Tunggu hingga proses pembuatan 

container CentOS 7 selesai dibuat dimana ditandai dengan pesan “TASK OK” pada 

bagian Output dari kotak dialog Task viewer: CT 101 – Create, seperti terlihat pada 

gambar berikut:  

 

Tutup kotak dialog Task viewer: CT 101 – Create. 
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Hasil dari pembuatan container CentOS 7 dengan ID 101, seperti terlihat pada gambar 

berikut: 

 

2. Untuk menjalankan Container CentOS 7, klik kanan pada “101 (server101.ubg.local)” 

di bawah node “pve” dari menu Datacenter dan pilih Start, seperti terlihat pada 

gambar berikut: 

 

Container CentOS 7 berhasil dijalankan dimana ditandai dengan pesan status OK untuk 

CT 100 - Start pada bagian Tasks dari Log Panel, seperti terlihat pada gambar berikut: 
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3. Untuk mengakses tampilan dari CT 101, pilih Console pada panel sebelah kanan dari 

CT 101 (server101.ubg.local), seperti terlihat pada gambar berikut: 

 

Tampil inputan Server Login untuk proses otentikasi sebelum pengguna dapat 

mengakses Command Line Interface (CLI) dari Container CentOS 7. Masukkan nama 

login “root” pada inputan Server Login dan tekan tombol Enter.  

Tampil inputan Password:, masukkan sandi login dari user “root” yaitu “12345678”, 

dan tekan tombol Enter. Apabila proses otentikasi login berhasil dilakukan maka akan 

tampil prompt CLI dari container CentOS 7 yang ditandai dengan tanda #, seperti 

terlihat pada gambar berikut: 

 

4. Untuk mematikan container CentOS 7, pada Console dari web interface administrasi 

Proxmox eksekusi perintah “poweroff”, seperti terlihat pada gambar berikut: 

 

Tunggu hingga proses shutdown selesai dilakukan. 
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LATIHAN: 

Lakukan pembuatan 2 (dua) container baru yaitu masing-masing dengan VM ID 102 dan 103, 

seperti terlihat pada gambar berikut: 

 

Detail ketentuan pengaturan parameter untuk setiap container, seperti terlihat pada tabel 

berikut: 

Parameter VM ID 102 VM ID 103 

Hostname server102-A.ubg.local server103-B.ubg.local 

Root Password 12345678 

Container Template CentOS 7 

Disk Size 4 GB 

CPU Core 1 

Memory 512 MB 

Swap 512 MB 

IP Address 192.168.169.102/24 192.168.169.103/24 
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Gateway 192.168.169.254 

DNS Domain ubg.local 

DNS Server 192.168.169.254 

Hasil akhir dari latihan pembuatan 2 (dua) container tersebut, seperti terlihat pada gambar 

berikut: 

 

Untuk keluar dari web interface administrasi Proxmox, klik tombol Logout pada bagian header 

paling kanan. 
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BAB V 

MANAJEMEN USER, GROUP, POOL DAN PERMISSION PADA PROXMOX VE 5.3 

 

Menurut wiki dari Proxmox, PVE mendukung berbagai sumber metode otentikasi 

pengguna meliputi Linux PAM, Proxmox VE Authentication Server, LDAP dan Microsoft Active 

Directory. Akses granular dapat didefinisikan dengan menggunakan manajemen user dan ijin 

akses (permission) berbasis role untuk keseluruhan objek seperti Virtual Machine (VM), storage, 

node dan lain-lain. PVE juga mendukung konsep group yang digunakan untuk mengatur ijin akses 

bagi sekelompok user. Selain itu terdapat konsep pool yang digunakan untuk mengelompokkan 

sekumpulan VM dan penyimpanan data. 

User memerlukan ijin akses yang sesuai untuk dapat melakukan aktivitas seperti melihat, 

mengubah atau menghapus konfigurasi dari VM. PVE menggunakan sistem manajemen berbasis 

role dan path. Role merupakan daftar dari hak akses. Terdapat berbagai role yang telah 

didefinisikan oleh PVE, antara lain: 

1. Administrator: memiliki keseluruhan ijin akses. 

2. NoAccess: tidak memiliki hak akses apapun (digunakan untuk menolak akses) 

3. PVEAdmin: dapat melakukan banyak hal, tetapi tidak dapat mengubah pengaturan 

sistem (Sys.PowerMgmt, Sys.Modify, Realm.Allocate). 

4. PVEAuditor: hanya akses read. 

5. PVEDatastoreAdmin: membuat dan mengalokasikan ruang backup dan templates. 

6. PVEDatastoreUser: mengalokasikan ruang backup dan view storage. 

7. PVEPoolAdmin: mengalokasikan pools.  

8. PVESysAdmin: User ACLs, audit, system console dan system logs. 

9. PVETemplateUser: view dan clone templates. 
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10. PVEUserAdmin: administrasi user. 

11. PVEVMAdmin: fully administer VMs. 

12. PVEVMUser: view, backup, mengatur CDROM, VM console, VM power management. 

Ijin akses diterapkan terhadap objek meliputi VM, storage atau pool dari sumber daya.  

PVE menggunakan path untuk mengalamati objek tersebut, sebagai contoh: 

1. /nodes/{node}: akses ke server Proxmox VE tertentu. 

2. /vms: mencakup keseluruhan VM. 

3. /vms/{vmid}: akses ke VM tertentu. 

4. /storage/{storeid}: akses ke media penyimpanan tertentu. 

5. /pool/{poolname}: akses ke VM dari pool tertentu. 

6. /access/groups: administrasi grup. 

7. /access/realms/{realmid}: akses administratif ke jenis realm tertentu. 

Sistem LFH dirancang untuk mengakomodir 2 (dua) jenis pengguna yaitu mahasiswa dan 

pengampu. Sebagai contoh terdapat 3 (tiga) user atau pengguna dengan metode otentikasi 

(realm) Proxmox VE Authentication Server yang akan dibuat, seperti terlihat pada tabel berikut: 

No. Username Password Path Role Group Deskripsi 

1. ali 12345678 /vms/100 PVEVMUser A Mahasiswa 

2. hasan /vms/101 B 

3. badu /pool/pengampu PVEVMAdmin  Dosen 

/groups PVEUserAdmin 

Terlihat terdapat 2 (dua) user yaitu ali dan hasan sebagai mahasiswa. Sedangkan satu user yaitu 

badu sebagai pengampu. User ali tergabung ke dalam kelompok (group) praktikum A dan 

memiliki role PVEVMUser pada objek CT ID 100 CentOS 7. Sedangkan user hasan tergabung ke 

dalam kelompok (group) praktikum B dan juga memiliki role PVEVMUser pada objek CT ID 101 

CentOS 7. Sebaliknya user badu memiliki 2 (dua) role yaitu PVEVMAdmin pada seluruh VM dari 

pengampu yang dikelompokkan ke dalam pool pengampu dan PVEUserAdmin pada group 

kelompok praktikum mahasiswa sehingga dapat membantu manajemen user mahasiswa. 
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Visualisasi dalam bentuk gambar dari rancangan user, group, pool dan permission pada 

PVE tersebut, seperti terlihat pada gambar berikut: 

 

Adapun langkah-langkah pembuatan user, group, pool dan pengaturan permission serta 

ujicoba berdasarkan rancangan user tersebut adalah sebagai berikut: 

1. Buka browser, sebagai contoh menggunakan Chrome. Pada address bar dari browser, 

masukkan URL https://192.168.169.1:8006. 

https://192.168.169.1:8006/
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2. Tampil kotak dialog otentikasi Proxmox VE Login, lengkapi isian “User name” dan 

“Password”. Pada isian “User name”, masukkan “root”. Sedangkan pada isian 

“Password”, masukkan sandi login dari user “root” yaitu 12345678, seperti terlihat 

pada gambar berikut:  

 

Klik tombol Login. Pengguna langsung diarahkan ke tampilan halaman Server View dari 

Proxmox. 

3. Membuat pool baru yaitu dengan nama A, B dan pengampu dengan dengan 

mengakses menu Data Center pada panel sebelah kiri dan pada panel sebelah kanan 

memilih submenu Pools dibawah menu Permissions serta memilih tombol Add, 

seperti terlihat pada gambar berikut: 

 

Tampil kotak dialog Create: Pool. Terdapat beberapa parameter yang diatur, seperti 

terlihat pada gambar berikut: 
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Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) Name:, digunakan untuk mengatur nama dari pool yaitu “A”. 

b) Comment:, digunakan untuk mengatur deskripsi dari pool yang dibuat. 

Klik tombol Create untuk memproses pembuatan pool “A” maka hasilnya akan terlihat 

seperti pada gambar berikut: 

 

Selanjutnya dengan cara sama, lakukan pula pembuatan pool dengan nama “B”.  

Klik tombol Create maka akan tampil kotak dialog Create: Pool. Terdapat beberapa 

parameter yang diatur, seperti terlihat pada gambar berikut: 

 

Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) Name:, digunakan untuk mengatur nama dari pool yaitu “B”. 
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b) Comment:, digunakan untuk mengatur deskripsi dari pool yang dibuat. 

Klik tombol Create untuk memproses pembuatan pool “B” maka hasilnya akan terlihat 

seperti pada gambar berikut: 

 

Selanjutnya dengan cara sama, lakukan pula pembuatan pool dengan nama 

“Pengampu”.  

Klik tombol Create maka akan tampil kotak dialog Create: Pool. Terdapat beberapa 

parameter yang diatur, seperti terlihat pada gambar berikut: 

 

Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) Name:, digunakan untuk mengatur nama dari pool yaitu “Pengampu”. 

b) Comment:, digunakan untuk mengatur deskripsi dari pool yang dibuat. 

Klik tombol Create untuk memproses pembuatan pool “Pengampu” maka hasilnya 

akan terlihat seperti pada gambar berikut: 
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4. Menambahkan VM sebagai anggota (members) dari pool A dengan mengakses nama 

pool yaitu A pada panel sebelah kiri dan pada panel detail sebelah kanan memilih menu 

Members serta memilih tombol Add > Virtual Machine, seperti terlihat pada gambar 

berikut: 

 

Pada kotak dialog Add: Virtual Machine yang tampil, tandai atau centang pada 

checkbox dari ID 100, seperti terlihat pada gambar berikut: 
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Klik tombol Add untuk memproses penambahan VM sebagai member dari pool 

tersebut, maka hasilnya akan terlihat seperti pada gambar berikut: 

 

5. Menambahkan VM sebagai anggota (members) dari pool B dengan mengakses nama 

pool yaitu B pada panel sebelah kiri dan pada panel detail sebelah kanan memilih menu 

Members serta memilih tombol Add > Virtual Machine, seperti terlihat pada gambar 

berikut: 

 

Pada kotak dialog Add: Virtual Machine yang tampil, tandai atau centang pada 

checkbox dari ID 101, seperti terlihat pada gambar berikut: 

 

Klik tombol Add untuk memproses penambahan VM sebagai member dari pool 

tersebut, maka hasilnya akan terlihat seperti pada gambar berikut: 
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6. Menambahkan VM sebagai anggota (members) dari pool Pengampu dengan 

mengakses nama pool yaitu Pengampu pada panel sebelah kiri dan pada panel detail 

sebelah kanan memilih menu Members serta memilih tombol Add > Virtual Machine, 

seperti terlihat pada gambar berikut: 

 

Pada kotak dialog Add: Virtual Machine yang tampil, tandai atau centang pada 

checkbox dari ID 102 dan 103, seperti terlihat pada gambar berikut: 

 

Klik tombol Add untuk memproses penambahan VM sebagai member dari pool 

tersebut, maka hasilnya akan terlihat seperti pada gambar berikut: 
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7. Membuat group baru yaitu dengan nama A dan B dengan mengakses menu Data 

Center pada panel sebelah kiri dan pada panel sebelah kanan memilih submenu 

Groups dibawah menu Permissions serta memilih tombol Add, seperti terlihat pada 

gambar berikut: 

 

Tampil kotak dialog Create: Group. Terdapat beberapa parameter yang diatur, seperti 

terlihat pada gambar berikut: 

 

Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) Name:, digunakan untuk mengatur nama dari group yaitu “A”. 

b) Comment:, digunakan untuk mengatur deskripsi dari group yang dibuat. 

Klik tombol Create untuk memproses pembuatan group “A” maka hasilnya akan 

terlihat seperti pada gambar berikut: 
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Selanjutnya dengan cara sama, lakukan pula pembuatan group dengan nama “B”.  

Klik tombol Create maka akan tampil kotak dialog Create: Group. Terdapat beberapa 

parameter yang diatur, seperti terlihat pada gambar berikut: 

 

Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) Name:, digunakan untuk mengatur nama dari group yaitu “B”. 

b) Comment:, digunakan untuk mengatur deskripsi dari group yang dibuat. 

Klik tombol Create untuk memproses pembuatan group “B” maka hasilnya akan 

terlihat seperti pada gambar berikut: 

 

8. Membuat user baru yaitu ali dan hasan serta badu dengan mengakses menu Data 

Center pada panel sebelah kiri dan pada panel sebelah kanan memilih submenu Users 
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dibawah menu Permissions serta memilih tombol Add, seperti terlihat pada gambar 

berikut: 

 

Tampil kotak dialog Add: User. Terdapat beberapa parameter yang diatur, seperti 

terlihat pada gambar berikut: 

 

Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) User name:, digunakan untuk mengatur nama login dari pengguna yaitu “ali”. 

b) Realm:, digunakan untuk menentukan metode otentikasi yang digunakan 

yaitu Proxmox VE authentication server. 

c) Password: dan Confirm Password: digunakan untuk mengatur sandi login dari 

user “ali” untuk container yaitu “12345678”. 

d) Group:, digunakan untuk mengatur group bagi user “ali” yaitu “A”. 
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e) First Name:, digunakan untuk mengatur nama depan dari akun pengguna yang 

dibuat yaitu “ali”. 

f) Comment:, digunakan untuk mengatur deskripsi dari akun pengguna yang 

dibuat yaitu “Mahasiswa”. 

Klik tombol Add untuk memproses pembuatan user “ali” maka hasilnya akan terlihat 

seperti pada gambar berikut: 

 

Selanjutnya dengan cara sama, lakukan pula pembuatan user “hasan”.  

Klik tombol Add maka akan tampil kotak dialog Add: User. Terdapat beberapa 

parameter yang diatur, seperti terlihat pada gambar berikut: 

 

Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) User name:, digunakan untuk mengatur nama login dari pengguna yaitu 

“hasan”. 
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b) Realm:, digunakan untuk menentukan metode otentikasi yang digunakan 

yaitu Proxmox VE authentication server. 

c) Password: dan Confirm Password: digunakan untuk mengatur sandi login dari 

user “hasan” untuk container yaitu “12345678”. 

d) Group:, digunakan untuk mengatur group bagi user “hasan” yaitu “B”. 

e) First Name:, digunakan untuk mengatur nama depan dari akun pengguna yang 

dibuat yaitu “hasan”. 

f) Comment:, digunakan untuk mengatur deskripsi dari akun pengguna yang 

dibuat yaitu “Mahasiswa”. 

Klik tombol Add untuk memproses pembuatan user “hasan” maka hasilnya akan 

terlihat seperti pada gambar berikut: 

 

Selanjutnya dengan cara sama, lakukan pula pembuatan user “badu”.  

Klik tombol Add maka akan tampil kotak dialog Add: User. Terdapat beberapa 

parameter yang diatur yaitu antara lain: 

a) User name:, digunakan untuk mengatur nama login dari pengguna yaitu 

“badu”. 

b) Realm:, digunakan untuk menentukan metode otentikasi yang digunakan 

yaitu Proxmox VE authentication server. 

c) Password: dan Confirm Password: digunakan untuk mengatur sandi login dari 

user “badu” untuk container yaitu “12345678”. 

d) First Name:, digunakan untuk mengatur nama depan dari akun pengguna yang 

dibuat yaitu “badu”. 
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e) Comment:, digunakan untuk mengatur deskripsi dari akun pengguna yang 

dibuat yaitu “Pengampu”. 

Hasil pengaturan tersebut, seperti terlihat pada gambar berikut: 

 

Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

Klik tombol Add untuk memproses pembuatan user “badu” maka hasilnya akan terlihat 

seperti pada gambar berikut: 

 

9. Menambahkan ijin akses agar user “ali” dapat mengakses objek CT ID 100 CentOS 7 

dengan mengakses menu Data Center pada panel sebelah kiri dan pada panel sebelah 

kanan pilih Permissions serta klik tombol Add > User Permission, seperti terlihat pada 

gambar berikut: 
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Pada kotak dialog Add: User Permission yang tampil terdapat beberapa parameter 

yang diatur, seperti terlihat pada gambar berikut: 

 

Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) Path:, digunakan untuk mengatur ijin akses ke objek VM dengan ID tertentu 

yaitu “/vms/100”. 

b) User:, digunakan untuk menentukan user yang diberikan akses terhadap path 

”/vms/100” yaitu “ali@pve”. 

c) Role: digunakan untuk mengatur role yang dialokasikan untuk user “ali@pve” 

yaitu “PVEVMUser”. Role tersebut memiliki ijin akses untuk melakukan 

aktivitas view, backup, config CDROM, VM console, dan VM power 

management. 
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Setelah penekanan tombol Add maka akan terlihat hasil dari pembuatan ijin akses 

untuk user “ali@pve”, seperti terlihat pada gambar berikut: 

 

10. Menambahkan ijin akses agar user “hasan” dapat mengakses objek CT ID 101 CentOS 

7 dengan mengakses menu Data Center pada panel sebelah kiri dan pada panel 

sebelah kanan pilih Permissions serta klik tombol Add > User Permission, seperti 

terlihat pada gambar berikut: 

 

Pada kotak dialog Add: User Permission yang tampil terdapat beberapa parameter 

yang diatur, seperti terlihat pada gambar berikut: 
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Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) Path:, digunakan untuk mengatur ijin akses ke objek LXC dengan ID tertentu 

yaitu “/vms/101”. 

b) User:, digunakan untuk menentukan user yang diberikan akses terhadap path 

”/vms/101” yaitu “hasan@pve”. 

c) Role: digunakan untuk mengatur role yang dialokasikan untuk user 

“hasan@pve” yaitu “PVEVMUser”. Role tersebut memiliki ijin akses untuk 

melakukan aktivitas view, backup, config CDROM, VM console, dan VM power 

management. 

Setelah penekanan tombol Add maka akan terlihat hasil dari pembuatan ijin akses 

untuk user “hasan@pve”, seperti terlihat pada gambar berikut: 

 

11. Menambahkan ijin akses agar user “badu” dapat mengakses seluruh objek pada pool 

Pengampu dengan mengakses menu Data Center pada panel sebelah kiri dan pada 

panel detail sebelah kanan memilih Permissions serta klik tombol Add > User 

Permission, seperti terlihat pada gambar berikut: 
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Pada kotak dialog Add: User Permission yang tampil terdapat beberapa parameter 

yang diatur, seperti terlihat pada gambar berikut: 

 

Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) Path:, digunakan untuk mengatur ijin akses terhadap objek pada pool tertentu 

yaitu “/pool/Pengampu”. 

b) User:, digunakan untuk menentukan user yang diberikan akses terhadap path 

”/pool/Pengampu” yaitu “badu@pve”. 

c) Role: digunakan untuk mengatur role yang dialokasikan untuk user 

“badu@pve” yaitu “PVEVMAdmin”. Role tersebut memiliki ijin akses untuk 

melakukan aktivitas manajemen pada objek VM yang menjadi anggota 

(member) pada pool tersebut secara penuh. 

Setelah penekanan tombol Add maka akan terlihat hasil dari pembuatan ijin akses 

untuk user “badu@pve”, seperti terlihat pada gambar berikut: 
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12. Menambahkan ijin akses agar user “badu” dapat memanajemen user yang terdapat 

pada seluruh group dengan mengakses menu Data Center pada panel sebelah kiri dan 

pada panel detail sebelah kanan memilih Permissions serta klik tombol Add > User 

Permission, seperti terlihat pada gambar berikut: 

 

Pada kotak dialog Add: User Permission yang tampil terdapat beberapa parameter 

yang diatur, seperti terlihat pada gambar berikut: 

 

Penjelasan dari setiap parameter yang dikonfigurasi adalah sebagai berikut: 

a) Path:, digunakan untuk mengatur ijin akses terhadap objek group yaitu 

“/access/groups”. 

b) User:, digunakan untuk menentukan user yang diberikan akses terhadap path 

”/pool/Pengampu” yaitu “badu@pve”. 

c) Role: digunakan untuk mengatur role yang dialokasikan untuk user 

“badu@pve” yaitu “PVEUserAdmin”. Role tersebut memiliki ijin akses untuk 
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melakukan aktivitas manajemen user yang tergabung dalam group secara 

penuh. 

Setelah penekanan tombol Add maka akan terlihat hasil dari pembuatan ijin akses 

untuk user “badu@pve” terkait pemberian hak manajemen user tersebut, seperti 

terlihat pada gambar berikut: 

 

13. Klik tombol Logout pada bagian pojok kanan atas untuk keluar dari PVE WebGUI 

sebagai user “admin” dari, seperti terlihat pada gambar berikut: 

 

14. Lakukan login kembali ke PVE WebGUI menggunakan user “ali” dengan password 

“123456” dan realm “Proxmox VE Authentication Server”, seperti terlihat pada 

gambar berikut: 
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Klik tombol Login. Apabila login sukses maka akan tampil Dashboard PVE. Pada panel 

sebelah kiri pilih Datacenter > PVE maka akan terlihat CT ID 100 seperti gambar 

berikut: 

 

Hal ini sesuai dengan ijin akses yang diberikan pada user “ali” yaitu hanya dapat 

mengakses objek CT ID 100 CentOS 7.  

Selanjutnya jalankan container CT ID 100 dengan cara klik kanan pada “100 

(server100.ubg.local)” di bawah node “pve” dari menu Datacenter dan pilih Start, 

seperti terlihat pada gambar berikut: 

 

Pada bagian Tasks dari Log Panel memperlihatkan pesan status OK untuk VM 100 – 

Start yang menyatakan bahwa VM tersebut berhasil dijalankan, seperti terlihat pada 

gambar berikut: 
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Selanjutnya untuk mengakses tampilan dari CT 100, pilih Console pada panel sebelah 

kanan dari CT 100 (server100.ubg.local), seperti terlihat pada gambar berikut: 

 

Tampil inputan server Login untuk proses otentikasi sebelum pengguna dapat 

mengakses Command Line Interface (CLI) dari CentOS 7. 

Selanjutnya lakukan shutdown CT 100 dengan cara klik kanan pada “100 

(server100.ubg.local)” di bawah node “pve” dari menu Datacenter dan pilih 

Shutdown, seperti terlihat pada gambar berikut: 

 

Tampil kotak dialog konfirmasi proses shutdown, tekan tombol Yes.  

Tunggu hingga proses shutdown selesai dilakukan dan Logout sebagai user “ali” dari 

PVE WebGUI. 

15. Lakukan login kembali ke PVE WebGUI menggunakan user “hasan” dengan password 

“123456” dan realm “Proxmox VE Authentication Server”, seperti terlihat pada 

gambar berikut: 
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Klik tombol Login. Apabila login sukses maka akan tampil Dashboard PVE. Pada panel 

sebelah kiri pilih Datacenter > PVE maka akan terlihat CT ID 101 seperti gambar 

berikut: 

 

Hal ini sesuai dengan ijin akses yang diberikan pada user “hasan” yaitu hanya dapat 

mengakses objek CT ID 101 CentOS 7.  

Selanjutnya jalankan CT ID 101 dengan cara klik kanan pada “101 

(server101.ubg.local)” di bawah node “pve” dari menu Datacenter dan pilih Start, 

seperti terlihat pada gambar berikut: 
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Pada bagian Tasks dari Log Panel memperlihatkan pesan status OK untuk CT 101 – 

Start yang menyatakan bahwa CT tersebut berhasil dijalankan, seperti terlihat pada 

gambar berikut: 

 

Selanjutnya untuk mengakses tampilan dari CT 101, pilih Console pada panel sebelah 

kanan dari CT 101 (server101.ubg.local), seperti terlihat pada gambar berikut: 

 

Tampil inputan server Login untuk proses otentikasi sebelum pengguna dapat 

mengakses Command Line Interface (CLI) dari CentOS 7. 

Selanjutnya lakukan shutdown CT 101 dengan cara klik kanan pada “101 

(server101.ubg.local)” di bawah node “pve” dari menu Datacenter dan pilih 

Shutdown, seperti terlihat pada gambar berikut: 

 

Tampil kotak dialog konfirmasi proses shutdown, tekan tombol Yes.  
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Tunggu hingga proses shutdown selesai dilakukan dan Logout sebagai user “hasan” 

dari PVE WebGUI. 

16. Lakukan login kembali ke PVE WebGUI menggunakan user “badu” dengan password 

“123456” dan realm “Proxmox VE Authentication Server”, seperti terlihat pada 

gambar berikut: 

 

Klik tombol Login. Apabila login sukses maka akan tampil Dashboard PVE. Pada panel 

sebelah kiri, pilih Datacenter > PVE maka akan terlihat CT ID 102 & 103, seperti gambar 

berikut: 

 

Pool yang dialokasikan ke user badu dapat dilihat dengan mengakses panel sebelah 

kiri dan memilih Pool View serta klik dua kali pada pool Pengampu maka akan terlihat 

VM yang menjadi member dari pool tersebut, seperti terlihat pada gambar berikut:  
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Hal tersebut sesuai dengan ijin akses yang diberikan ke user “badu” yaitu hanya dapat 

mengakses objek yang menjadi member dari pool Pengampu yaitu VM ID 102 & 103 

CentOS 7.  

Selanjutnya lakukan verifikasi terkait ijin akses yang diberikan ke user “badu” terkait 

manajemen user yang terdapat pada seluruh group yaitu A & B dengan mengakses 

panel menu Datacenter di sebelah kiri dan pada panel detail memilih Users, seperti 

terlihat pada gambar berikut: 

 

Terlihat user mahasiswa yaitu “ali” yang menjadi anggota dari group A dan “hasan” 

yang menjadi anggota dari group B. Badu dapat membantu melakukan aktivitas 

manajemen user seperti reset password user tersebut dan lain sebagainya.  

Logout sebagai user “badu” dari PVE WebGUI. 
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BAB VI 

BACKUP DAN RESTORE PADA PROXMOX VE 5.3 

 

A. BACKUP 

Backup merupakan proses untuk membuat salinan dari data dan konfigurasi VM/CT untuk 

digunakan ketika data atau konfigurasi tersebut hilang atau rusak. PVE backup bertipe full backup 

yang didalamnya memuat konfigurasi VM/CT dan data. Backup storage perlu didefinisikan 

terlebih dahulu sebelum backup dapat dijalankan. Hal ini dapat diketahui dengan mengakses PVE 

WebGUI dan memilih Datacenter pada panel sebelah kiri dari halaman Server View serta memilih 

Storage pada panel sebelah kanan, seperti terlihat pada gambar berikut:  

 

Terlihat secara default, storage “local” dapat digunakan untuk menyimpanan file backup. 

Adapun langkah-langkah untuk melakukan backup LXC pada PVE adalah sebagai berikut: 

1. Buka browser, sebagai contoh menggunakan Chrome. Pada address bar dari browser, 

masukkan URL https://192.168.169.1:8006. 

2. Tampil kotak dialog otentikasi Proxmox VE Login, lengkapi isian “User name” dan 

“Password”. Pada isian “User name”, masukkan “root”. Sedangkan pada isian 

“Password”, masukkan sandi login dari user “root” yaitu 12345678. Selain itu pastikan 

pilihan “Realm” adalah Linux PAM standard authentication, seperti terlihat pada 

gambar berikut:  

https://192.168.169.1:8006/
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Klik tombol Login. Pengguna langsung diarahkan ke tampilan halaman Server View dari 

Proxmox. 

3. Pastikan CT ID 100 (server100.ubg.local) dalam keadaan aktif atau running. Apabila 

belum maka lakukan pengaktifan terlebih dahulu sehingga hasilnya akhirnya terlihat 

seperti gambar berikut: 

 

4. Proses backup VM diawali dengan melakukan navigasi ke menu Datacenter > PVE  

pada panel sebelah kiri dari halaman Server view dan memilih VM ID 100 

(server100.ubg.local). Selanjutnya pilih Backup  Backup Now pada panel sebelah 

kanan, seperti terlihat pada gambar berikut: 
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Tampil kotak dialog Backup VM 100. Terdapat beberapa parameter yang harus 

dikonfigurasi, seperti terlihat pada gambar berikut: 

 

Penjelasan parameter: 

a) Storage: digunakan untuk menentukan lokasi penyimpanan file backup yaitu 

local. 

b) Mode:, untuk menentukan mode backup yang akan digunakan.  

Menurut wiki dari Proxmox terdapat 3 (tiga) pilihan mode backup untuk CT 

yaitu stop, suspend dan snapshot.  

 Stop mode 

Container akan dihentikan (stop) selama proses backup sehingga 

memiliki downtime yang sangat lama. 

 Suspend mode 

Menggunakan rsync untuk menyalinkan data dari container ke lokasi 

sementara. Selanjutnya container akan ditangguhkan (suspended) dan 

salinan rsync kedua mengubah file. Setelah itu container akan 

dijalankan kembali sehingga memiliki downtime yang minimal tetapi 

membutuhkan tambahan kapasitas penyimpanan untuk menampung 

salinan dari container. 

 Snapshot mode 

Mode ini menggunakan fasilitas snapshotting dari penyimpanan yang 

mendasarinya. Pertama, container akan ditangguhkan untuk 

memastikan konsistensi pada data. Snapshot sementara dari volume 
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container akan dibuat dan konten snapshot akan diarsipkan dalam file 

tar. Terakhir, snapshot sementara akan dihapus lagi. 

Secara default telah terpilih yaitu snapshot. 

c) Compression:, digunakan untuk menentukan jenis kompresi dari file backup. 

Terdapat 3 (tiga) pilihan yaitu none (tanpa kompresi), LZO (fast) dan GZIP 

(good). Secara default telah terpilih LZO (fast). 

Klik tombol Backup untuk memulai backup.  

Tampil kotak dialog Task viewer: Backup yang menampilkan proses backup, seperti 

terlihat pada gambar berikut: 

 

Tunggu hingga proses backup selesai dilakukan yang ditandai dengan pesan TASK OK. 

Tutup kotak dialog Task viewer: Backup.  

Hasil dari backup, seperti terlihat pada gambar berikut: 
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B. RESTORE 

Sebelum mencontohkan operasi restore dari file backup maka terlebih dahulu akan 

dilakukan shutdown pada CT ID 100 (server100.ubg.local).  Proses shutdown dilakukan 

dengan cara klik kanan pada CT ID 100 dan memilih Shutdown pada panel sebelah kiri dari 

Server View PVE, seperti terlihat pada gambar berikut: 

 

Tunggu hingga proses shutdown selesai dilakukan.  

Selanjutnya akan dilakukan penghapusan CT ID 100 (server100.ubg.local).  Proses 

penghapusan dilakukan dengan cara memilih CT ID 100 (server100.ubg.local) pada panel 

sebelah kiri dari Server View PVE dan pada panel sebelah kanan memilih tombol More > 

Remove, seperti terlihat pada gambar berikut: 
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Tampil kotak dialog konfirmasi CT 100 –Destroy. Pada inputan parameter “Please enter the ID 

to confirm (100):”, masukkan 100 dan tekan tombol Remove, seperti terlihat pada gambar 

berikut: 

 

Tunggu hingga proses penghapusan CT selesai dilakukan.  

Hasil akhir ketika CT ID 100 telah dihapus, seperti terlihat pada gambar berikut: 

 

Adapun langkah-langkah untuk melakukan restore CT adalah sebagai berikut: 

1. Mengakses konten dari storage local yang menampung file backup dengan cara 

memilih Datacenter > PVE > local (pve) pada panel sebelah kiri dari Server View PVE, 

seperti terlihat pada gambar berikut: 

 

Terlihat satu file backup dari CT ID 100. 
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2. Pilih file “vzdump-lxc-100-2020_06_05-21_10_33.tar.lzo” dan klik tombol Restore 

untuk melakukan pemulihan atau pengembalian CT ID 100, seperti terlihat pada 

gambar berikut: 

 

Tampil kotak dialog Restore: CT. Terdapat beberapa parameter yang memerlukan 

pengaturan, seperti terlihat pada gambar berikut: 

 

Penjelasan parameter: 

a) Storage:, menentukan media penyimpanan yang akan digunakan sebagai 

tujuan pemulihan CT yaitu local-lvm. 

b) CT ID:, menentukan Container Identifier (ID) yang akan digunakan oleh CT yang 

dipulihkan yaitu 100. 

Klik tombol Restore maka akan tampil kotak dialog Task viewer: CT 100 – Restore yang 

memperlihatkan proses pemulihan CT, seperti terlihat pada gambar berikut: 
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Tunggu hingga proses pemulihan CT selesai dilakukan yang ditandai dengan pesan 

TASK OK. Tutup kotak dialog Task viewer: CT 100 – Restore. 

Hasil akhir dari proses restore CT ID 100, seperti terlihat pada gambar berikut: 

 

Terlihat CT ID 100 telah berhasil dipulihkan. Selanjutnya CT tersebut dapat diujicoba 

untuk dijalankan dan diakses melalui Console, seperti terlihat pada gambar berikut: 

 

Terlihat Console dari CT ID 100 telah berhasil diakses. 
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3. Lakukan pengaturan kembali agar VM ID 100 menjadi member dari pool A dan user 

“ali” memiliki ijin akses berupa role PVEVMUser terhadap VM ID 100 dengan cara yang 

telah dijelaskan pada bab sebelumnya.  

 

C. SCHEDULED BACKUP 

Aktivitas backup dapat dieksekusi secara terjadwal sehingga eksekusi dilakukan 

berdasarkan waktu yang ditentukan dan untuk node atau sistem guest (VM/CT) terpilih. 

Backup terjadwal dapat dilakukan dengan memilih menu Datacenter pada panel sebelah kiri 

dari Server View PVE dan pada panel sebelah kanan memilih menu Backup serta klik tombol 

Add, seperti terlihat pada gambar berikut: 

 

Tampil kotak dialog Create: Backup Job. Terdapat beberapa parameter yang memerlukan 

pengaturan pada kotak dialog tersebut, antara lain: 

a) Storage, digunakan untuk menentukan lokasi penyimpanan file backup yaitu local. 

b) Day of week, digunakan untuk menentukan hari dalam seminggu backup akan 

dieksekusi yaitu Friday. 

c) Start Time, digunakan untuk menentukan jam backup akan dieksekusi yaitu 13:45. 

d) Selection mode, digunakan untuk menentukan mode seleksi dari VM/CT yang akan 

dibackup yaitu Include selected VMs (memasukkan VM terpilih untuk dibackup). 

Terdapat pilihan lainnya yaitu All dan Exclude selected VMs. 

e) Compression, digunakan untuk menentukan jenis kompresi dari file backup. Terdapat 

3 (tiga) pilihan yaitu none (tanpa kompresi),  LZO (fast) dan GZIP (good). Secara default 

telah terpilih LZO (fast). 
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f) Mode, untuk menentukan mode backup yang akan digunakan. Terdapat 3 (tiga) pilihan 

yaitu stop, suspend dan snapshot. Secara default telah terpilih yaitu snapshot. 

Seleksi atau tandai VM atau CT yang akan dibackup yaitu CT ID 101. Hasil pengaturan pada 

parameter tersebut, seperti terlihat pada gambar berikut: 

 

Klik tombol Create untuk membuat backup terjadwal.  

Hasil dari pembuatan backup terjadwal, terlihat seperti pada gambar berikut: 
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Sedangkan hasil dari backup terjadwal yang telah tereksekusi pada jadwal yang telah 

ditentukan untuk CT ID 101, seperti terlihat pada gambar berikut: 

 

Terlihat file backup berhasil terbuat. 
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BAB VII 

INSTALASI DAN KONFIGURASI MIKROTIK CHR INTERNET SERVICE PROVIDER 

(ISP) PADA VMWARE WORKSTATION 15 

 

Untuk menjembatani kebutuhan akses Internet dan simulasi Virtual Private Network 

(VPN) maka pada VMWare Workstation akan diinstalasi Mikrotik CHR 6.43.8 sebagai Virtual 

Machine (VM) dan dikonfigurasi sebagai Internet Server Provider (ISP), seperti terlihat pada 

gambar berikut: 

 

MikroTik CHR memiliki 3 (tiga) interface yaitu ether1 dengan jenis koneksi NAT dan ether2 serta 

ether3 dengan jenis koneksi host-only. Pengalamatan IP pada interface ether1 dialokasikan 

secara dinamis sehingga bertindak sebagai DHCP Client. Sedangkan interface ether2 

menggunakan alamat IP 198.51.100.2/30 dan ether3 menggunakan alamat IP 198.51.100.5/30.  
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Adapun langkah-langkah instalasi dan konfigurasi MikroTik CHR yang difungsikan sebagai 

ISP pada VMWare Workstation 15 Pro adalah sebagai berikut: 

1. Jalankan aplikasi VMWare Workstation 15 Pro melalui Start > VMWare > VMWare 

Workstation Pro. 

2. Tampil aplikasi VMWare Workstation. Untuk membuat virtual machine baru, pilih menu 

File > New Virtual Machine …, seperti terlihat pada gambar berikut: 

 

3. Tampil kotak dialog New Virtual Machine Wizard untuk menentukan jenis konfigurasi 

virtual machine yang ingin dibuat, seperti terlihat pada gambar berikut: 
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Terdapat 2 pilihan jenis konfigurasi yang dapat dipilih yaitu Typical (recommended) dan 

Custom (advanced). Jenis konfigurasi Typical disarankan untuk dipilih ketika ingin 

membuat virtual machine melalui beberapa tahapan dengan mudah. Sebaliknya jenis 

konfigurasi Custom akan memberikan pilihan pengaturan lanjutan seperti penentuan jenis 

controller SCSI, jenis virtual disk dan kompatibilitas dengan produk VMWare versi 

sebelumnya. Pilih Custom (advanced), dan klik tombol Next > untuk melanjutkan. 

4. Tampil kotak dialog Choose the Virtual Machine Hardware Compatibility untuk 

menentukan kompatibilitas perangkat keras dari virtual machine, seperti terlihat pada 

gambar berikut: 

 

Secara default telah terpilih Workstation 15.x pada pilihan parameter Hardware 

compatibility. Klik tombol Next > untuk melanjutkan. 

5. Tampil kotak dialog Guest Operating System Installation untuk menentukan bagaimana 

cara instalasi sistem operasi dilakukan, seperti terlihat pada gambar berikut: 
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Terdapat 3 pilihan yaitu Install from Installer disc untuk menginstalasi dari media disc 

seperti CD/DVD, Install from Installer disc image file (iso) untuk menginstalasi dari file 

ISO, dan I will install the operating system later untuk mempersiapkan virtual machine 

dengan hardisk kosong tanpa melakukan instalasi sistem operasi. Pilih I will install the 

operating system later, dan klik tombol Next > untuk melanjutkan. 

6. Tampil kotak dialog Select a Guest Operating System untuk menentukan jenis sistem 

operasi yang akan diinstalasi pada virtual machine yang dibuat, seperti ditunjukkan pada 

gambar berikut: 
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Pilih Other pada bagian Guest operating system dan Other 64-bit pada bagian Version. 

Klik tombol Next > untuk melanjutkan. 

7. Tampil kotak dialog Name the Virtual Machine untuk menentukan nama pengenal virtual 

machine dan menentukan lokasi penyimpanan file virtual machine yang dibuat. Pada 

bagian Virtual machine name masukkan nama pengenal virtual machine, sebagai contoh 

MikroTik-CHR-ISP. Apabila diperlukan pada bagian Location dapat pula ditentukan 

lokasi penyimpanan file virtual machine yang dibuat dengan cara menekan tombol Browse 

…., seperti terlihat pada gambar berikut: 
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Klik tombol Next > untuk melanjutkan. 

8. Tampil kotak dialog Processor Configuration untuk menentukan jumlah prosesor yang 

digunakan oleh virtual machine yang dibuat, seperti terlihat pada gambar berikut: 

 

Secara default telah terpilih 1 (satu) baik untuk jumlah prosesor maupun jumlah core per 

prosesor. Klik tombol Next > untuk melanjutkan. 
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9. Tampil kotak dialog Memory for the Virtual Machine untuk menentukan kapasitas memori 

yang dialokasikan untuk virtual machine yang dibuat. Pada isian dari parameter Memory 

for this virtual machine, masukkan 256 MB, seperti terlihat pada gambar berikut: 

 

Klik tombol Next > untuk melanjutkan. 

10. Tampil kotak dialog Network Type untuk menentukan jenis koneksi jaringan yang 

digunakan, seperti terlihat pada gambar berikut: 
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Pilih use network address translation (NAT). Klik tombol Next > untuk melanjutkan. 

11. Tampil kotak dialog Select I/O Controller Types untuk menentukan jenis SCSI controller 

yang ingin digunakan, seperti terlihat pada gambar berikut: 

 

Secara default telah terpilih LSI Logic yang merupakan pilihan yang direkomendasikan. 

Klik tombol Next > untuk melanjutkan. 

12. Tampil kotak dialog Select a Disk Type untuk menentukan jenis disk yang akan dibuat, 

seperti terlihat pada gambar berikut: 
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Secara default telah terpilih IDE yang merupakan pilihan yang direkomendasikan. Klik 

tombol Next > untuk melanjutkan. 

13. Tampil kotak dialog Select a Disk untuk menentukan disk yang ingin digunakan, seperti 

terlihat pada gambar berikut: 
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Pilih Use an existing virtual disk untuk menggunakan virtual disk yang telah ada yaitu chr-

6.43.8.vmdk yang telah diunduh dari situs Mikrotik. Klik tombol Next > untuk 

melanjutkan. 

14. Tampil kotak dialog Select an existing disk untuk mengarahkan ke lokasi virtual disk yang 

ingin digunakan. Klik tombol Browse… dan arahkan ke lokasi penyimpanan file chr-

6.43.8.vmdk, sebagai contoh berada di C:\Users\ASUS\Documents\Virtual 

Machines\Mikrotik-CHR-ISP, seperti terlihat pada gambar berikut: 

 

Klik tombol Next > untuk melanjutkan. 

15. Tampil kotak dialog Convert existing virtual disk to newer format? yang 

menginformasikan bahwa virtual disk terpilih dapat dikonversi ke format lebih baru yang 

di dukung oleh Workstation 15.x, seperti terlihat pada gambar berikut: 

 

Klik tombol Convert untuk mengkonversi ke format Workstation 15.x. 

https://mikrotik.com/download
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16. Tampil kotak dialog Ready to Create Virtual Machine yang memperlihatkan ringkasan 

pengaturan virtual machine yang akan dibuat, seperti terlihat pada gambar berikut: 

 

Klik tombol Customize Hardware… untuk menambahkan network adapter kedua maka 

akan tampil kotak dialog Hardware, seperti terlihat pada gambar berikut: 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 104 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

 

Klik tombol Add.  

Tampil kotak dialog Hardware Type yang digunakan untuk menentukan jenis perangkat 

keras yang ingin diinstalasi, seperti terlihat pada gambar berikut: 
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Pilih Network Adapter pada pilihan Hardware types: dan klik tombol Finish maka akan 

tampil kembali kotal dialog Hardware yang telah memperlihatkan hasil penambahan 

Network Adapter 2. Lakukan perubahan Network Connection dari Network Adapter 2 

menjadi Host-only, seperti terlihat pada gambar berikut: 

 

Selanjutnya dengan cara yang sama, lakukan penambahan Network Adapter kembali. 

Klik tombol Add. Tampil kotak dialog Hardware Type yang digunakan untuk menentukan 

jenis perangkat keras yang ingin diinstalasi, seperti terlihat pada gambar berikut: 
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Pilih Network Adapter pada pilihan Hardware types: dan klik tombol Finish maka akan 

tampil kembali kotal dialog Hardware yang telah memperlihatkan hasil penambahan 

Network Adapter 3. Lakukan perubahan Network Connection dari Network Adapter 3 

menjadi Host-only, seperti terlihat pada gambar berikut: 

 

Klik tombol Close untuk menutup kotak dialog Hardware. 

Klik tombol Finish untuk membuat virtual machine. 

17. Tampil kotak dialog yang menampilkan virtual machine yang telah berhasil dibuat yaitu 

dengan nama pengenal MikroTik-CHR-ISP, seperti terlihat pada gambar berikut: 
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Selanjutnya klik Power on the virtual machine untuk menghidupkan virtual machine 

seperti terlihat pada gambar berikut: 

 

18. Tampil inputan Mikrotik Login untuk proses otentikasi sebelum pengguna dapat 

mengakses Command Line Interface (CLI) dari Mikrotik, seperti terlihat pada gambar  

berikut: 

 

Masukkan nama login “admin” pada inputan MikroTik Login dan tekan tombol Enter. 

Selanjutnya tampil inputan Password:. Tekan tombol Enter untuk melanjutkan karena 

password untuk user “admin” adalah kosong (blank), seperti terlihat pada gambar 

berikut: 

 

Selanjutnya tampil pesan “Do you want to see the software license? [Y/n]”, tekan “n” 

untuk tidak menampilkan lisensi perangkat lunak. Terlihat prompt CLI dari Mikrotik, 

seperti gambar berikut: 

  

19. Mengubah hostname dari MikroTik menjadi “ISP” menggunakan perintah: 

system identity set name=ISP 

 

20. Menampilkan informasi interface yang dimiliki oleh router Mikrotik menggunakan 

perintah: 
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interface print 

 

Terlihat terdapat 3 (tiga) interface yaitu ether1 dan ether2 serta ether3. 

21. Menampilkan informasi interface dengan pengaturan DHCP Client menggunakan 

perintah: 

ip dhcp-client print 

 

Terlihat terdapat satu interface yang diatur sebagai DHCP Client yaitu ether1. 

22. Mengatur pengalamatan IP pada interface ether2 secara statik menggunakan 

198.51.100.2/30 menggunakan perintah: 

ip address add address=198.51.100.2/30 interface=ether2 

 

23. Memverifikasi pengalamatan IP yang telah diatur pada interface ether2 menggunakan 

perintah: 

ip address print 

 

24. Mengatur pengalamatan IP pada interface ether3 secara statik menggunakan 

198.51.100.5/30 menggunakan perintah: 

ip address add address=198.51.100.5/30 interface=ether3 

 

25. Memverifikasi pengalamatan IP yang telah diatur pada interface ether3 menggunakan 

perintah: 

ip address print 
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26. Menampilkan informasi tabel routing menggunakan perintah: 

ip route print 

 

Terlihat alamat default gateway yang digunakan oleh router Mikrotik adalah 

192.168.238.2. 

27. Memverifikasi koneksi ke default gateway menggunakan perintah: 

ping 192.168.238.2 

 

Tekan CTRL+C untuk menghentikan ping. 

28. Mengatur agar router Mikrotik bertindak sebagai Server DNS menggunakan perintah: 

ip dns set allow-remote-requests=yes 

 

29. Memverifikasi pengaturan Server DNS menggunakan perintah ip dns print. 
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30. Mengatur Internet Connection Sharing (ICS) dengan mengaktifkan fitur Network Address 

Translation (NAT) menggunakan perintah: 

ip firewall nat add chain=srcnat out-interface=ether1 

action=masquerade 

 

31. Memverifikasi hasil pengaturan NAT menggunakan perintah: 

ip firewall nat print 

 

32. Memverifikasi koneksi Internet menggunakan perintah ping ke salah satu situs di Internet. 

 

Tekan CTRL+C untuk menghentikan ping. 
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BAB VIII 

INSTALASI DAN KONFIGURASI MIKROTIK CHR INTERNET GATEWAY DAN 

VIRTUAL PRIVATE NETWORK (VPN) SERVER PADA VMWARE WORKSTATION 15 

 

Untuk menjembatani kebutuhan akses Internet dari Proxmox VE 5.3 maka pada VMWare 

Workstation akan diinstalasi Mikrotik CHR 6.43.8 sebagai Virtual Machine (VM) dan dikonfigurasi 

sebagai gateway untuk berbagi pakai koneksi Internet. Selain itu pada VM Mikrotik CHR 6.43.8 

Gateway juga dikonfigurasi layanan Virtual Private Network (VPN) sehingga sistem LFH dapat 

diakses oleh pengguna secara jarak jauh, seperti terlihat pada gambar berikut: 

 

MikroTik CHR Gateway memiliki 2 (dua) interface yaitu ether1 dan ether2 dengan jenis koneksi 

host-only. Interface ether1 menggunakan alamat IP 198.51.100.1/30. Sedangkan interface ether2 

menggunakan alamat IP 192.168.169.254/24.  
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A. INSTALASI VM MIKROTIK CHR GATEWAY 

Adapun langkah-langkah instalasi dan konfigurasi MikroTik CHR sebagai gateway Internet 

pada VMWare Workstation 15 Pro adalah sebagai berikut: 

1. Jalankan aplikasi VMWare Workstation 15 Pro melalui Start > VMWare > VMWare 

Workstation Pro. 

2. Tampil aplikasi VMWare Workstation. Untuk membuat virtual machine baru, pilih menu 

File > New Virtual Machine …, seperti terlihat pada gambar berikut: 

 

3. Tampil kotak dialog New Virtual Machine Wizard untuk menentukan jenis konfigurasi 

virtual machine yang ingin dibuat, seperti terlihat pada gambar berikut: 
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Terdapat 2 pilihan jenis konfigurasi yang dapat dipilih yaitu Typical (recommended) dan 

Custom (advanced). Jenis konfigurasi Typical disarankan untuk dipilih ketika ingin 

membuat virtual machine melalui beberapa tahapan dengan mudah. Sebaliknya jenis 

konfigurasi Custom akan memberikan pilihan pengaturan lanjutan seperti penentuan jenis 

controller SCSI, jenis virtual disk dan kompatibilitas dengan produk VMWare versi 

sebelumnya. Pilih Custom (advanced), dan klik tombol Next > untuk melanjutkan. 

4. Tampil kotak dialog Choose the Virtual Machine Hardware Compatibility untuk 

menentukan kompatibilitas perangkat keras dari virtual machine, seperti terlihat pada 

gambar berikut: 

 

Secara default telah terpilih Workstation 15.x pada pilihan parameter Hardware 

compatibility. Klik tombol Next > untuk melanjutkan. 

5. Tampil kotak dialog Guest Operating System Installation untuk menentukan bagaimana 

cara instalasi sistem operasi dilakukan. Terdapat 3 pilihan yaitu Install from Installer disc 

untuk menginstalasi dari media disc seperti CD/DVD, Install from Installer disc image file 

(iso) untuk menginstalasi dari file ISO, dan I will install the operating system later untuk 

mempersiapkan virtual machine dengan hardisk kosong tanpa melakukan instalasi sistem 

operasi, seperti terlihat pada gambar berikut: 
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Pilih I will install the operating system later, dan klik tombol Next > untuk melanjutkan. 

6. Tampil kotak dialog Select a Guest Operating System untuk menentukan jenis sistem 

operasi yang akan diinstalasi pada virtual machine yang dibuat, seperti ditunjukkan pada 

gambar berikut: 
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Pilih Other pada bagian Guest operating system dan Other 64-bit pada bagian Version. 

Klik tombol Next > untuk melanjutkan. 

7. Tampil kotak dialog Name the Virtual Machine untuk menentukan nama pengenal virtual 

machine dan menentukan lokasi penyimpanan file virtual machine yang dibuat. Pada 

bagian Virtual machine name masukkan nama pengenal virtual machine, sebagai contoh 

MikroTik-CHR-GW. Apabila diperlukan pada bagian Location dapat pula ditentukan 

lokasi penyimpanan file virtual machine yang dibuat dengan cara menekan tombol Browse 

…., seperti terlihat pada gambar berikut: 

 

Klik tombol Next > untuk melanjutkan. 

8. Tampil kotak dialog Processor Configuration untuk menentukan jumlah prosesor yang 

digunakan oleh virtual machine yang dibuat, seperti terlihat pada gambar berikut: 
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Secara default telah terpilih 1 (satu) baik untuk jumlah prosesor maupun jumlah core per 

prosesor. Klik tombol Next > untuk melanjutkan. 

9. Tampil kotak dialog Memory for the Virtual Machine untuk menentukan kapasitas memori 

yang dialokasikan untuk virtual machine yang dibuat. Pada isian dari parameter Memory 

for this virtual machine, masukkan 256 MB, seperti terlihat pada gambar berikut: 

 

Klik tombol Next > untuk melanjutkan. 
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10. Tampil kotak dialog Network Type untuk menentukan jenis koneksi jaringan yang 

digunakan, seperti terlihat pada gambar berikut: 

 

Pilih Use host-only networking. Klik tombol Next > untuk melanjutkan. 

11. Tampil kotak dialog Select I/O Controller Types untuk menentukan jenis SCSI controller 

yang ingin digunakan, seperti terlihat pada gambar berikut: 

 

Secara default telah terpilih LSI Logic yang merupakan pilihan yang direkomendasikan. 

Klik tombol Next > untuk melanjutkan. 
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12. Tampil kotak dialog Select a Disk Type untuk menentukan jenis disk yang akan dibuat, 

seperti terlihat pada gambar berikut: 

 

Secara default telah terpilih IDE yang merupakan pilihan yang direkomendasikan. Klik 

tombol Next > untuk melanjutkan. 

13. Tampil kotak dialog Select a Disk untuk menentukan disk yang ingin digunakan, seperti 

terlihat pada gambar berikut: 
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Pilih Use an existing virtual disk untuk menggunakan virtual disk yang telah ada yaitu chr-

6.43.8.vmdk yang telah diunduh dari situs Mikrotik. Klik tombol Next > untuk 

melanjutkan. 

14. Tampil kotak dialog Select an existing disk untuk mengarahkan ke lokasi virtual disk yang 

ingin digunakan. Klik tombol Browse… dan arahkan ke lokasi penyimpanan file chr-

6.43.8.vmdk, sebagai contoh berada di C:\Users\ASUS\Documents\Virtual 

Machines\Mikrotik-CHR-GW, seperti terlihat pada gambar berikut: 

 

Klik tombol Next > untuk melanjutkan. 

15. Tampil kotak dialog Convert existing virtual disk to newer format? yang 

menginformasikan bahwa virtual disk terpilih dapat dikonversi ke format lebih baru yang 

di dukung oleh Workstation 15.x, seperti terlihat pada gambar berikut: 

 

https://mikrotik.com/download
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Klik tombol Convert untuk mengkonversi ke format Workstation 15.x. 

16. Tampil kotak dialog Ready to Create Virtual Machine yang memperlihatkan ringkasan 

pengaturan virtual machine yang akan dibuat, seperti terlihat pada gambar berikut: 

 

Klik tombol Customize Hardware… untuk menambahkan network adapter kedua maka 

akan tampil kotak dialog Hardware, seperti terlihat pada gambar berikut: 
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Klik tombol Add.  

 

Tampil kotak dialog Hardware Type yang digunakan untuk menentukan jenis perangkat 

keras yang ingin diinstalasi, seperti terlihat pada gambar berikut: 
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Pilih Network Adapter pada pilihan Hardware types: dan klik tombol Finish maka akan 

tampil kembali kotal dialog Hardware yang telah memperlihatkan hasil penambahan 

Network Adapter 2, seperti terlihat pada gambar berikut: 

 

Lakukan perubahan network connection dari Network Adapter 2 menjadi Host-only. 

Klik tombol Close untuk menutup kotak dialog Hardware. 

Klik tombol Finish untuk membuat virtual machine. 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 123 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

17. Tampil kotak dialog yang menampilkan virtual machine yang telah berhasil dibuat yaitu 

dengan nama pengenal MikroTik-CHR-GW, seperti terlihat pada gambar berikut: 

 

Selanjutnya klik Power on the virtual machine untuk menghidupkan virtual machine 

seperti terlihat pada gambar berikut: 

 

18. Tampil inputan Mikrotik Login untuk proses otentikasi sebelum pengguna dapat 

mengakses Command Line Interface (CLI) dari Mikrotik, seperti terlihat pada gambar  

berikut: 

 

Masukkan nama login “admin” pada inputan MikroTik Login dan tekan tombol Enter. 
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Selanjutnya tampil inputan Password:. Tekan tombol Enter untuk melanjutkan karena 

password untuk user “admin” adalah kosong (blank), seperti terlihat pada gambar berikut: 

 

Selanjutnya tampil pesan “Do you want to see the software license? [Y/n]”, tekan “n” 

untuk tidak menampilkan lisensi perangkat lunak. Terlihat prompt CLI dari Mikrotik, 

seperti gambar berikut: 

  

19. Mengubah hostname dari router MikroTik menjadi “GW” menggunakan perintah: 

system identity set name=GW 

 

20. Menampilkan informasi interface yang dimiliki oleh router Mikrotik menggunakan 

perintah: 

interface print 

 

Terlihat terdapat 2 (dua) interface yaitu ether1 dan ether2. 

21. Mengatur pengalamatan IP pada interface ether1 secara statik menggunakan 

198.51.100.1/30 dengan mengeksekusi perintah: 

ip address add address=198.51.100.1/30 interface=ether1 

 

22. Memverifikasi pengalamatan IP yang telah diatur pada interface ether1 dengan 

mengeksekusi perintah: 

ip address print 
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23. Mengatur pengalamatan IP pada interface ether2 secara statik menggunakan 

192.168.169.254/24 dengan mengeksekusi perintah: 

ip address add address=192.168.169.254/24 interface=ether2 

 

24. Memverifikasi pengalamatan IP yang telah diatur pada interface ether2 dengan 

mengeksekusi perintah: 

ip address print 

 

25. Mengatur default route agar router Mikrotik dapat terkoneksi ke Internet melalui ISP 

menggunakan perintah: 

ip route add gateway=198.51.100.2 

 

26. Menampilkan informasi tabel routing menggunakan perintah: 

ip route print 

 

27. Memverifikasi koneksi ke router ISP yang berfungsi sebagai default gateway 

menggunakan perintah: 

ping 198.51.100.2 

 

Tekan CTRL+C untuk menghentikan ping. 

28. Mengatur agar router Mikrotik menggunakan alamat IP dari router ISP yaitu 198.51.100.2 

sebagai Server DNS dan memfungsikan diri sendiri sebagai Server DNS untuk jaringan 

lokal dengan mengeksekusi perintah: 
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ip dns set servers=198.51.100.2 allow-remote-requests=yes 

 

29. Memverifikasi pengaturan Server DNS dengan mengeksekusi perintah: 

ip dns print 

 

30. Mengatur Internet Connection Sharing (ICS) dengan mengaktifkan fitur Network Address 

Translation (NAT) menggunakan perintah: 

ip firewall nat add chain=srcnat out-interface=ether1 

action=masquerade 

 

31. Memverifikasi hasil pengaturan NAT dengan mengeksekusi perintah: 

ip firewall nat print 

 

32. Memverifikasi koneksi Internet menggunakan perintah ping ke salah satu situs di Internet. 

 

Tekan CTRL+C untuk menghentikan ping. 

 

 

 

 

 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 127 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

B. PENGENALAN VIRTUAL PRIVATE NETWORK (VPN) 

Menurut WhatIsMyIPAddress.com, VPN merupakan teknologi jaringan yang digunakan 

untuk membuat koneksi jaringan yang aman melalui jaringan publik seperti Internet atau jaringan 

privat milik penyedia layanan. Terdapat 2 (dua) jenis VPN yaitu Remote Access dan Site-to-Site. 

 

VPN Remote Access (Sumber: https://wiki.mikrotik.com/wiki/Manual:Interface/PPTP) 

 

VPN Site-to-Site (Sumber: https://wiki.mikrotik.com/wiki/Manual:Interface/PPTP) 

https://whatismyipaddress.com/
https://wiki.mikrotik.com/wiki/Manual:Interface/PPTP
https://wiki.mikrotik.com/wiki/Manual:Interface/PPTP


 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 128 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

Terdapat beragam protokol VPN dimana salah satunya adalah Point-to-Point Tunneling Protocol 

(PPTP).  

Menurut wiki Mikrotik, PPTP adalah secure tunnel yang dapat digunakan untuk melakukan 

transport IP menggunakan PPP. PPTP mengenkapsulasi PPP pada line virtual yang berjalan diatas 

IP. PPTP menggabungkan PPP dan Microsoft Point to Point Encryption (MPPE) untuk membuat 

link yang terenkripsi. Tujuan PPTP adalah untuk dapat memanajemen dengan baik koneksi yang 

aman antara router-router dan antara router dengan client PPTP yang terdapat di seluruh sistem 

operasi. PPTP mendukung otentikasi PPP dan accounting untuk masing-masing koneksi PPTP. 

Otentikasi dan accounting untuk masing-masing koneksi dapat dilakukan melalui RADIUS client 

dan secara lokal. 

Sistem LFH yang dibangun menggunakan VPN PPTP dengan topologi, seperti terlihat pada 

gambar berikut: 

LAN SERVER
192.168.169.0/24

vmbr0
.1

MIKROTIK
GATEWAY

(PPTP SERVER)

ether1
.1

ether2
.254 ISP

ether2
.2

.5
ether3

SUBNET GW-ISP
198.51.100.0/30

SUBNET ISP-CLIENT INTERNET 
198.51.100.4/30Server Proxmox Virtual

Environment (PVE)

Ethernet
.6

Windows Client Internet
(PPTP Client)

INTERNET

Internet
Server

ether1

 

PPTP terdiri dari dua bagian yaitu PPTP Server dan PPTP Client. Mikrotik CHR Gateway 

difungsikan sebagai PPTP Server. Sedangkan Windows Client Internet difungsikan sebagai PPTP 

Client. Ketika PPTP Client melakukan koneksi ke PPTP Server maka akan dialokasikan 

pengalamatan IP secara dinamis dari alamat network 192.168.170.0/24. Alamat IP pertama pada 

network tersebut yaitu 192.168.170.1 dialokasikan secara statik untuk interface dari PPTP Server. 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 129 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

Sedangkan alamat IP kedua sampai terakhir yaitu 192.168.170.2 - 192.168.170.254 dialokasikan 

untuk PPTP Client. 

 

B. MENGAKSES ROUTER MIKROTIK CHR GATEWAY MELALUI WINBOX 

Adapun langkah-langkah untuk mengakses router Mikrotik CHR Gateway melalui aplikasi 

Winbox adalah sebagai berikut: 

1. Mengunduh aplikasi Winbox dari situs Mikrotik pada alamat 

https://mikrotik.com/download, seperti terlihat pada gambar berikut: 

 

Pilih Winbox > Winbox 3.21 (64-bit) atau Winbox 3.21 (32-bit) untuk mengunduh 

aplikasi tersebut ke komputer yang digunakan, seperti terlihat pada gambar berikut: 

 

2. Jalankan aplikasi Winbox yang telah diunduh. 

https://mikrotik.com/download
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3. Tampil kotak dialog aplikasi Winbox, seperti terlihat pada gambar berikut: 

 

Untuk dapat mengakses Mikrotik maka terdapat 3 (tiga) parameter yang harus dilengkapi 

pada kotak dialog login dari aplikasi Winbox yaitu: 

a) Connect to (digunakan untuk memasukkan alamat IP atau alamat MAC dari router 

Mikrotik yang akan diakses),  

b) Login (nama login pengguna yang digunakan untuk mengakses router Mikrotik), 

dan  

c) Password (sandi login pengguna yang digunakan untuk mengakses router 

Mikrotik). Secara default Mikrotik telah membuatkan satu user untuk tujuan 

administrasi yaitu dengan nama login “admin” dengan password kosong (tanpa 

sandi).  

Inputan Connect to dapat diisi secara otomatis melalui pemanfaatan Mikrotik Neighbor 

Discovery Protocol (MNDP) yang dapat mendeteksi router Mikrotik yang terhubung 

secara langsung dengan komputer yang digunakan yaitu dengan cara memilih tab 

Neighbors di bagian bawah dari Winbox, seperti terlihat pada gambar berikut: 
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Terdeteksi satu router Mikrotik CHR GW dan CHR ISP. Apabila belum terdeteksi atau 

terlihat informasi daftar router Mikrotik CHR GW maka klik tombol Refresh. 

Dari daftar router yang ditemukan, pilih isian kolom MAC Address atau IP untuk 

terkoneksi ke router Mikrotik CHR GW tersebut, seperti terlihat pada gambar berikut: 

 

Karena Mikrotik CHR GW telah memiliki alamat IP maka pilih pada alamat IP 

192.168.169.254 yang tampil, dan lengkapi parameter Login dengan isian “admin”, seperti 

terlihat pada gambar berikut: 

 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 132 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

Selanjutnya tekan tombol “Connect” untuk menghubungkan ke router Mikrotik CHR 

GW. 

4. Tampil kotak dialog yang menampilkan panel menu untuk mengkonfigurasi router 

Mikrotik CHR GW, seperti terlihat pada gambar berikut: 

 

 

C. KONFIGURASI VPN PPTP SERVER PADA MIKROTIK CHR GATEWAY 

Adapun langkah-langkah konfigurasi VPN PPTP Server pada Mikrotik CHR Gateway 

melalui Winbox adalah sebagai berikut: 

1. Membuat Pool untuk mengalokasikan pengalamatan IP secara dinamis ke PPTP Client 

dengan mengakses menu IP > Pool pada panel menu sebelah kiri dari Winbox. Tampil 

kotak dialog IP Pool, seperti terlihat pada gambar berikut: 
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Pilih tombol  pada toolbar dari kotak dialog IP Pool maka akan tampil kotak dialog 

New IP Pool, seperti terlihat pada gambar berikut: 

 

Terdapat beberapa parameter yang harus diisi pada kotak dialog ini yaitu: 

a) Name, digunakan untuk mengatur nama pengenal untuk pool yang dibuat yaitu 

PoolVPN.  

b) Addresses, digunakan untuk menentukan jangkauan alamat IP yang didistribusikan 

secara dinamis ke PPTP Client yaitu 192.168.170.2 – 192.168.170.254. 

Isian dari masing-masing parameter dengan nilai yang telah ditentukan, terlihat seperti 

pada gambar berikut: 

 

Untuk menyimpan pengaturan klik tombol OK.  

Hasil dari pengaturan IP Pool akan terlihat seperti pada gambar berikut: 
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Tutup kotak dialog IP Pool. 

2. Mengatur PPP Profiles dengan mengakses menu PPP pada panel menu sebelah kiri dari 

Winbox, seperti terlihat pada gambar berikut: 

 

Pada kotak dialog PPP yang tampil, pilih tab Profiles, seperti terlihat pada gambar berikut: 

 

Pilih tombol  pada toolbar dari kotak dialog PPP maka akan tampil kotak dialog New 

PPP Profile, seperti terlihat pada gambar berikut: 
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Terdapat beberapa parameter yang harus diisi pada tab General dari kotak dialog ini yaitu: 

a) Name, digunakan untuk mengatur nama pengenal dari profile yang dibuat yaitu 

ProfileVPN.  

b) Local Address, digunakan untuk menentukan alamat IP yang akan diberikan ke 

interface PPTP server (local) yaitu 192.168.170.1. 

c) Remote Address, digunakan untuk menentukan alamat IP yang akan diberikan ke 

interface PTPP Client (remote) yaitu dalam hal ini diambil dari IP Pool. Pilih 

PoolVPN.  

Isian dari masing-masing parameter dengan nilai yang telah ditentukan untuk tab General, 

terlihat seperti pada gambar berikut: 

 

Selanjutnya pindah ke tab Protocols dan lakukan pengaturan pada parameter Use 

Encryption agar menerapkan enkripsi dengan memilih “yes”, seperti terlihat pada gambar 

berikut: 

 

Selanjutnya pindah ke tab Limits dan lakukan pengaturan pada parameter Only One agar 

pengguna hanya dapat membuat satu sesi PPTP menggunakan akun PPP yang dimiliki 

dengan memilih “yes”, seperti terlihat pada gambar berikut: 
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Klik tombol OK untuk menyimpan pengaturan.  

Hasil dari penambahan PPP Profile akan terlihat seperti pada gambar berikut: 

 

3. Mengaktifkan PPP Server dengan memilih tab Interface pada kotak dialog PPP dan 

menekan tombol PPTP Server pada toolbar, seperti terlihat pada gambar berikut: 

 

Tampil kotak dialog PPTP Server, seperti terlihat pada gambar berikut: 
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Terdapat beberapa parameter yang diatur pada kotak dialog PPTP Server yaitu: 

a) Centang atau tandai () pada checkbox parameter Enabled.  

b) Default Profile, digunakan untuk menentukan PPP profile yang digunakan yaitu 

ProfileVPN. 

Klik tombol OK untuk menyimpan pengaturan. 

4. Membuat user VPN dengan nama “ali”, “hasan” dan “badu” dengan memilih tab Secrets 

pada kotak dialog PPP, seperti terlihat pada gambar berikut: 

 

Pilih tombol  pada toolbar dari kotak dialog PPP maka akan tampil kotak dialog New 

PPP Profile, seperti terlihat pada gambar berikut: 

 

Terdapat beberapa parameter yang harus diatur yaitu: 

a) Name: nama login pengguna yaitu “ali”. 

b) Password: sandi login pengguna yaitu “12345678”. 

c) Service: menentukan layanan yang dapat menggunakan user tersebut yaitu pptp. 
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d) Profile: menentukan PPP profile yang digunakan yaitu ProfileVPN. 

Hasil pengaturan parameter pada kotak dialog tersebut akan terlihat seperti pada gambar 

berikut: 

 

Klik tombol OK untuk menyimpan. Hasil dari penambahan user VPN dengan nama “ali”, 

seperti terlihat pada gambar berikut: 

 

Dengan cara sama, pilih tombol  pada toolbar dari kotak dialog PPP untuk membuat 

user VPN dengan nama “hasan”. Terdapat beberapa parameter yang harus diatur pada 

kotak dialog New PPP Secret yaitu: 

a) Name: nama login pengguna yaitu “hasan”. 

b) Password: sandi login pengguna yaitu “12345678”. 

c) Service: menentukan layanan yang dapat menggunakan user tersebut yaitu pptp. 

d) Profile: menentukan PPP profile yang digunakan yaitu ProfileVPN. 

Hasil pengaturan parameter pada kotak dialog tersebut akan terlihat seperti pada gambar 

berikut: 
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Klik tombol OK untuk menyimpan.  

Hasil dari penambahan user VPN dengan nama “hasan”, seperti terlihat pada gambar 

berikut: 

 

Selanjutnya dengan cara sama pula, pilih tombol  pada toolbar dari kotak dialog PPP 

untuk membuat user VPN dengan nama “badu”. Terdapat beberapa parameter yang harus 

diatur pada kotak dialog New PPP Secret yaitu: 

a) Name: nama login pengguna yaitu “badu”. 

b) Password: sandi login pengguna yaitu “12345678”. 

c) Service: menentukan layanan yang dapat menggunakan user tersebut yaitu pptp. 

d) Profile: menentukan PPP profile yang digunakan yaitu ProfileVPN. 

Hasil pengaturan parameter pada kotak dialog tersebut akan terlihat seperti pada gambar 

berikut: 
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Klik tombol OK untuk menyimpan.  

Hasil dari penambahan user VPN dengan nama “badu”, seperti terlihat pada gambar 

berikut: 

 

5. Melihat PPTP Client yang sedang terkoneksi ke PPTP Server dapat dilakukan dengan 

memilih tab Active Connections pada kotak dialog PPP, seperti terlihat pada gambar 

berikut: 

 

Terlihat belum terdapat sesi koneksi PPTP Client yang aktif. 
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BAB IX 

KONFIGURASI PENGALAMATAN IP DAN VPN CLIENT CONNECTION 

PADA WINDOWS 10 

 

Untuk mengujicoba akses ke sistem LFH dari Internet maka pada VMWare Workstation 

dibuat satu VM dengan sistem operasi Windows yang difungsikan sebagai VPN Client, seperti 

terlihat pada gambar berikut: 

 

Terlihat VM Windows VPN Client memiliki satu interface dengan nama Ethernet0 bertipe host-

only yang terhubung ke router Mikrotik CHR ISP. Alamat network yang digunakan untuk jaringan 

yang menghubungkan router Mikrotik CHR ISP dengan Windows VPN Client adalah 

198.51.100.4/30. Alamat IP yang digunakan oleh Windows VPN Client adalah 198.51.100.6/30 

dengan default gateway 198.51.100.5. 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 142 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

A. KONFIGURASI PENGALAMATAN IP PADA CLIENT WINDOWS 10 

Adapun langkah-langkah konfigurasi pengalamatan IP yang dilakukan pada Client Windows 

10 adalah sebagai berikut: 

1. Klik kanan pada icon Network  yang terdapat pada bagian pojok kanan bawah dari taskbar 

dan pilih Open Network & Sharing Center, seperti terlihat pada gambar berikut: 

 

2. Tampil kotak dialog Network and Sharing Center. Pilih Change Adapter Settings, seperti 

terlihat pada gambar berikut:  

 

3. Tampil kotak dialog Network Connections. Klik dua kali pada Ethernet0, seperti terlihat pada 

gambar berikut: 
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4. Tampil kotak dialog Ethernet0 Status. Klik tombol Properties, seperti terlihat pada gambar 

berikut: 

 

5. Tampil kotak dialog Ethernet0 Properties. Pada bagian “This connection uses the following 

items:”, klik dua kali pada pilihan Internet Protocol Version 4 (TCP/IPv4), seperti terlihat 

pada gambar berikut: 
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6. Tampil kotak dialog Internet Protocol Version 4 (TCP/IPv4) Properties. Pilih Use the following 

IP Address, seperti terlihat pada gambar berikut: 
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Pada isian IP address:, masukkan 198.51.100.6 dan pada isian Subnet mask:, masukkan 

255.255.255.252. Sedangkan pada isian Default Gateway dan Preferred DNS Server, 

masukkan 198.51.100.5. Klik tombol OK > OK > Close. Tutup kotak dialog Network and 

Sharing Center. 

7. Buka Command Prompt Windows dengan menekan tombol Windows+R. Pada inputan form 

yang tampil, ketik“cmd” dan tekan tombol Enter. 

 

8. Verifikasi koneksi dari client Windows 10 ke Mikrotik CHR ISP menggunakan perintah “ping 

198.51.100.5” pada Command Prompt Windows, seperti terlihat pada gambar berikut: 

 

Terlihat koneksi ke Mikrotik CHR ISP telah berhasil dilakukan. 

9. Verifikasi koneksi dari client Windows 10 ke Mikrotik CHR GW yang bertindak sebagai VPN 

Server menggunakan perintah “ping 198.51.100.1” pada Command Prompt Windows, 

seperti terlihat pada gambar berikut: 
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Terlihat koneksi ke Mikrotik CHR GW telah berhasil dilakukan. 

10. Verifikasi koneksi dari client Windows 10 ke salah satu situs di Internet menggunakan 

perintah “ping google.com” pada Command Prompt Windows, seperti terlihat pada gambar 

berikut: 

 

Terlihat koneksi ke google.com telah berhasil dilakukan. 

 

B. KONFIGURASI VPN CLIENT CONNECTION PADA WINDOWS 10 

Adapun langkah-langkah untuk mengkonfigurasi VPN Client Connection pada Windows 10 

adalah sebagai berikut: 

1. Klik kanan pada icon Network  yang terdapat pada bagian pojok kanan bawah dari 

taskbar dan pilih Open Network & Sharing Center, seperti terlihat pada gambar berikut: 
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2. Tampil kotak dialog Network and Sharing Center. Pilih Set up a new connection or 

network, seperti terlihat pada gambar berikut:  

 

3. Pada kotak dialog Set up a new connection or network yang tampil, pilih Connect to a 

workplace, seperti terlihat pada gambar berikut:  

 
Klik tombol Next untuk melanjutkan. 
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4. Pada kotak dialog Connect to a workplace parameter How do you want to connect?, pilih 

Use my Internet connection (VPN), seperti terlihat pada gambar berikut: 

 

5. Tampil kotak dialog Connect to a workplace parameter Type the Internet address to 

connect to. Pada bagian Internet address masukkan alamat IP dari VPN Server yaitu 

198.51.100.1 dan pada bagian Destination name masukkan “VPN LFH” sebagai nama 

pengenal VPN Connection yang dibuat, seperti terlihat pada gambar berikut: 
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Klik tombol Create. 

6. Pada kotak dialog Network and Sharing Center, pilih Change adapter settings, seperti 

terlihat pada gambar berikut: 

 

7. Tampil kotak dialog Network Connections. Klik dua kali pada VPN Connection yang telah 

dibuat yaitu dengan nama “VPN LFH”, seperti terlihat pada gambar berikut:  

 

8. Pada kotak dialog Settings yang tampil, pilih VPN Connection yang telah dibuat 

sebelumnya yaitu “VPN LFH” dan klik tombol Connect, seperti terlihat pada gambar 

berikut: 
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9. Tampil kotak dialog Windows Security Sign in untuk memasukkan akun otentikasi koneksi 

VPN. Sebagai contoh masukkan User name “ali” dengan Password “12345678”, seperti 

terlihat pada gambar berikut:  

 

Klik OK untuk . Tunggu beberapa saat hingga muncul pesan Connected yang menandakan 

bahwa koneksi ke VPN Server berhasil dilakukan, seperti terlihat pada gambar berikut: 
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10. Verifikasi koneksi dari VPN Client Windows 10 ke server PVE dari sistem LFH menggunakan 

perintah “ping 192.168.169.1” pada Command Prompt Windows, seperti terlihat pada 

gambar berikut: 

 

Terlihat koneksi ke server PVE telah berhasil dilakukan dari VPN Client. 

 

C. AKSES WEB GUI SERVER PVE SISTEM LFH DARI VPN CLIENT 

Adapun langkah-langkah untuk mengakses Web GUI Server PVE dari VPN Client Windows 

10 adalah sebagai berikut: 

1. Buka browser sebagai contoh menggunakan Chrome. Pada address bar dari browser, 

masukkan URL https://192.168.169.1:8006. Hasil pengaksesan, seperti terlihat pada 

gambar berikut: 

 

https://192.168.169.1:8006/
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Tampil pesan peringatan “Your connection is not private”. Klik Advanced untuk 

melanjutkan pengaksesan dan klik link “Proceed to 192.168.169.1 (unsafe)”, seperti 

terlihat pada gambar berikut: 

 

Maka web interface dari konfigurasi Proxmox berhasil diakses, seperti terlihat pada 

gambar berikut: 
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2. Pada kotak dialog otentikasi Proxmox VE Login, lengkapi isian “User name” dan 

“Password” serta pilihan “Realm”. Lengkapi isian “User name” dengan “ali” dan pada 

isian “Password”dengan “12345678”. Sedangkan pada pilihan jenis “Realm”, pilih 

“Proxmox VE authentication server”, seperti terlihat pada gambar berikut:  

 

Klik tombol Login. 

3. Tampil halaman Server View dari Proxmox. Klik dua kali pada node “pve” yang terdapat di 

panel sebelah kiri yaitu dibawah menu Datacenter. Terlihat container ID 100 

(server100.ubg.local) yang dapat diakses atau digunakan oleh user “ali”, seperti terlihat 

pada gambar berikut: 

 

Jalankan container tersebut dengan klik kanan pada “100 (server100.ubg.local)” dan pilih 

Start, seperti terlihat pada gambar berikut: 

 



 

  

COPYRIGHT 2020 WWW.UNIVERSITASBUMIGORA.AC.ID 154 

 

MODUL TRAINING MEMBANGUN SISTEM LAB FROM HOME (LFH) 

Tunggu beberapa saat hingga status dari container tersebut running, seperti terlihat pada 

gambar berikut: 

 

4. Untuk mengakses tampilan dari CT 100, pilih Console pada panel sebelah kanan dari CT 

100 (server100.ubg.local), seperti terlihat pada gambar berikut: 

 

Tampil inputan Server Login untuk proses otentikasi sebelum pengguna dapat mengakses 

Command Line Interface (CLI) dari container tersebut.  

Masukkan nama login “root” pada inputan Server Login dan tekan tombol Enter.  

Tampil inputan Password:, masukkan sandi login dari user “root” yaitu “12345678”, dan 

tekan tombol Enter. Apabila proses otentikasi login berhasil dilakukan maka akan tampil 

prompt CLI dari container tersebut yang ditandai dengan tanda #, seperti terlihat pada 

gambar berikut: 

 

Selanjutnya dapat dilakukan aktivitas praktikum sesuai materi yang terdapat pada diktat 

praktikum dari matakuliah Administrasi Sistem Jaringan (ASJ). Sebagai contoh menginstalasi dan 

mengkonfigurasi server Secure Shell (SSH). 
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D. INSTALASI DAN KONFIGURASI SSH SERVER PADA CONTAINER ID 100 

Adapun langkah-langkah menginstalasi dan mengkonfigurasi SSH Server pada CT ID 100 

adalah sebagai berikut: 

1. Menginstalasi paket aplikasi OpenSSH agar container dapat di akses secara remote 

melalui SSH Client pada VPN Client Windows 10 menggunakan perintah yum -y 

install openssh openssh-server openssh-clients openssl-libs 

 

Tampil proses instalasi paket, seperti terlihat pada gambar berikut: 

 

Tunggu hingga proses instalasi selesai dilakukan. 

2. Mengaktifkan service sshd agar layanan SSH Server dengan mengeksekusi perintah 

systemctl start sshd 

 

3. Memverifikasi hasil pengaktifkan service sshd dengan mengeksekusi perintah 

systemctl status sshd 

 

Terlihat service sshd telah aktif. 

 

E. REMOTE ACCESS SSH KE CONTAINER ID 100 DARI VPN CLIENT WINDOWS 10 

Adapun langkah-langkah untuk melakukan remote access SSH ke container ID 100 dari VPN 

Client Windows 10 adalah sebagai berikut: 
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1. Jalankan aplikasi Putty maka akan tampil kotak dialog Putty Configuration. Pada isian 

Host Name (or IP Address), masukkan alamat IP dari container yaitu 192.168.169.100, 

seperti terlihat pada gambar berikut: 

 

Klik tombol Open.  

Tampil kotak dialog Putty Security Alert yang menampilkan pesan peringatan terkait 

potensi pelanggaran keamanan, klik tombol Yes untuk melanjutkan. 

Selanjutnya tampil kotak dialog Putty yang meminta pengguna untuk melakukan 

proses otentikasi login ke container, seperti terlihat pada gambar berikut: 

 

Pada inputan login as:, masukkan “root” dan tekan tombol Enter. Selanjutnya tampil 

inputan password:, masukkan “12345678” dan tekan tombol Enter. Apabila proses 

otentikasi berhasil dilakukan maka akan tampil shell prompt #. 

Keluar dari SSH menggunakan perintah exit, seperti terlihat pada gambar berikut: 
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2. Untuk mematikan container, pada Console dari web interface administrasi Proxmox 

eksekusi perintah “poweroff”, seperti terlihat pada gambar berikut: 

 

Tunggu hingga proses shutdown selesai dilakukan. 

3. Untuk keluar dari web interface administrasi Proxmox, klik tombol Logout pada bagian 

header paling kanan. 

 

Terakhir, lakukan pemutusan koneksi VPN dengan mengakses icon Network  yang terdapat pada 

bagian pojok kanan bawah dari taskbar dan memilih VPN LFH serta menekan tombol 

Disconnect, seperti terlihat pada gambar berikut: 
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